





rradiation and DC vield potential of
solar highways In the Netherlands

by

Carlotta Ferri

to obtain the degree of Master of Science in Sustainable Energy Technology
at the Delft University of Technology,
to be defended publicly on Tuesday September 3, 2019 at 2:00 PM.

Student number: 4749723
Project duration: December 3, 2019 — August 27, 2019
Thesis committee: H. Ziar, TU Delft, EEMCS, daily supervisor
Dr. O. Isabella, TU Delft, EEMCS, supervisor
Prof. Dr. A. H. M. Smets, TU Delft, EEMCS
Dr. G. Agugiaro, TU Delft Architecture and the Built Environment

This thesis is confidential and cannot be made public until August 26, 2021.

An electronic version of this thesis is available at http://repository.tudelft.nl/.

]
TUDelft


http://repository.tudelft.nl/




Preface

”I would put my money on the sun and solar energy. What a source of power! I hope we don'’t
have to wait until oil and coal run out before we tackle that.”

Thomas Edison, 1931






Abstract

With cities getting more densely populated and more energy-demanding, infrastructure in-
tegrated PV technology has gained more interest from researchers, companies and govern-
mental institutions. Among the many urban surfaces that have been studied to be used to
generate solar energy, roads are one of the most enticing but controversial as well. Ques-
tions regarding their feasibility and costs arise, such as if they can withstand traffic load or
if they will ever be cheap enough to compete with conventional systems. However, it is first
of all crucial to understanding if their energy potential will be sufficient to make solar road
installations a reasonable investment to begin with.

As rooftop irradiation maps start to become the hotspot in the branch of solar energy mod-
elling, the same attention should be directed to solar roads. This research aims to develop a
modelling methodology to easily and quickly estimate the potential of solar roads and provide
the first irradiation and DC yield potential map of solar highways in the Netherlands. The
map could serve as a useful tool for advisory of research, private industry and governmental
projects that helps to individuate optimal sites for solar road installation in the Netherlands.

The average irradiation along highways is found to be around 880 KWh/m?/y, 35% less
than the potential of an optimally tilted conventional PV installation in South Holland. The
most irradiated highways result to be A31, A5 and A200, with average irradiation between
980 and 1000 KWh/m?/y. The analysis of the sky view factor along the highways discloses
that in most of the cases highways are in almost free horizon conditions. This makes them
an appealing location for PV installations.

The DC yield potential of solar highways is obtained assuming three different technolo-
gies: monocrystalline silicon, polycrystalline silicon and CIGS. The energy output is modelled
using a solar road-specific temperature model, which accounts for conductive heat exchange
between the layers. The scenario of having the entire Dutch highways network renovated into
solar roads is considered unrealistic. Therefore, a glueable solar road technology is assumed,
similar to the one developed by the French company Wattway by Colas.

Solar highways can generate on average a DC yield of 138 kWh/m?/y in the Netherlands if
polycrystalline silicon is assumed. This value can increase up to 174 kWh/m? /y if monocrys-
talline silicon technology is implemented. In total, covering the entire Dutch highways net-
work with solar road modules could generate between 3.4 and 6.6 TWh/y of electricity. This
could be used to power 36% of the national street lighting demand.

In addition to that, a model is developed that aims to address another compelling question
regarding solar road feasibility: what is the impact of traffic? Two case studies are conducted
on two of the four busiest roads in the Netherlands, the A12 and A16, based on real traffic
data. It is found that traffic accounts for an average of 3% reduction of solar road irradiation
potential, with a maximum reduction of 7% in particular locations, such as bridges and in
the nearby of ramp roads. The value, comparable with inverter conversion losses, does not
significantly impact on the output power but still needs to be taken into consideration when
designing the PV system of a solar road.

The research presented here aims to spark the interest from the research, the industry and
the government towards solar road applications. By giving a first estimate of the irradiation
and DCyield potential of the whole Dutch highways network, this aims to act as a springboard
for improvements and further development in solar road modelling.
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Abbrevations

All the technical abbreviations used in this report are listed here below and explained in the
text when they are mentioned for the first time.

AM  Air Mass

ASL Anti-Skid Layer

Aol Angle of Incidence

DC Direct Current

EV Electric Vehicles

IIPV Infrastructure Integrated Photo Voltaic
LED Light Emitting Diode

LiDAR Light Detection and Ranging or Laser Imaging Detection and Ranging
PVC Polyvinyl Chloride

PVF Polyvinyl Fluoride

PVNB Photo Voltaic on Noise Barrier

PV Photo Voltaic

SCF Sun Coverage Factor

STC Standard Test Conditions

SVF Sky View Factor






Introduction

In this chapter, the motivation of the research is introduced. It is explained how roads are
recognized to have a high irradiation potential that has been left unused until now. The
research objectives are listed and the methodology is explained. The questions that will be
answered in details in the report are also indicated. Eventually, an outline of the structure
and content of the report is provided.

1.1. Motivation of the research study

In the last decade infrastructure integrated PV (IIPV) technology has gained more interest
from the side of both industry and research, as it is a promising technology for the real-
ization of sustainable urban energy supply. In particular, it would support the increased
power demand in the urban environment. In fact, according to Statistics Netherlands and
the Ministry of Economic Affair, cities are getting more densely populated and energy de-
manding, especially on roads due to the increasing advent of electric vehicles (EVs) and the
electrification of public transport system [10]. Additionally, decentralized power conversion
through IIPV shows a potential economic benefit from the minimization of grid dependence
and transmission losses for urban infrastructures like buildings, street lighting, etc [19].

What IIPV technology offers in addition to conventional photovoltaic systems is the reso-
lution of the land constrain issue [26] [19]. In fact, providing power with a reasonable energy
density from photovoltaic technology requires a great amount of land. In [26], the author
claims that if the US should be entirely powered by photovoltaic energy, 181 m? per person
of land area would need to be covered with photovoltaic modules, which corresponds on av-
erage to 0.6% of the US land area. Considering a total US area of 9.8 million km? it results in
54,000 km?, a dimension comparable with the area of the Netherlands. This land competes
with housing, transportation and even more with agriculture. In fact, optimal sites for pho-
tovoltaic systems installation are found to correspond with cultivated land since both the two
sectors need an area that is potentially well-insolated, flat and horizon-free, has road adja-
cency to facilitate the transport of goods/materials but also the connection for workers and
access for machinery/maintenance. Hence, a scaling up of photovoltaic power conversion
could raise a future conflict between the agriculture and sustainable energy sector [32].

All this considered, the idea of integrating photovoltaic technology in already existing built-
up surfaces becomes very enticing because no additional space is needed and only a limited
infrastructure adjustment is required. According to A. S. Dezfooli et al. in [16], roads have
a great irradiation potential, absorbing up to 40 MJ/m? daily and an interesting study of S.
Najem in [50] already disclosed the correlation between cities’ road network size and their
solar potential. After [19], harvesting energy from solar roads would permit to maximize the
utilization of land dedicated to transportation.

Roads are additionally a source of heat in the urban areas, contributing to the well-known
effect of the urban heat island. According to C. Efthymiou et al. in [23], photovoltaic roads
could reduce the urban surface temperature in comparison with conventional pavements due

5



6 1. Introduction

to the fact that a share of light is reflected or converted into electricity. The study revealed
that incorporating solar modules in the road surface, would allow a decrease of 5° on the
road surface and of 3° in the ambient temperature.

In addition, considering that urban areas are responsible for 40% of the total CO2 emis-
sions, different methods have already been approached to make the road construction sector
more sustainable: bituminous asphalt containing waste material, solar asphalt and imple-
mentation of PV technology for electricity demand on streets [16].

The Netherlands Organisation for Applied Scientific Research (abbreviated to TNO from
the Dutch name Nederlandse Organisatie voor Toegepast Natuurwetenschappelijk Onder-
zoek) claims that the Dutch road network, which accounts for around 135.000 km, can
harvest enough electricity to power all the cars in the country with clean energy. The orga-
nization recognizes a great potential for solar roads linked with electric mobility (e-mobility)
[66]. In fact, electric vehicles cannot be considered a revolution towards a sustainable prod-
uct, unless they are powered with electricity generated from renewable sources. Solar roads
would play a decisive part, providing clean power where it is needed. Additionally, this could
become a great opportunity to revolutionize the transportation sector, including new smart
functions in the road itself, such as sensors to collect traffic and temperature data, gener-
ation of variable road marking, integrated LED lights, wireless energy transfer to vehicles
(inductive charging) and even automatic vehicle guidance [635].

The aim of this research project is to provide a first map of the Dutch highways network,
which drafts the irradiation and DC yield potential of solar roads for three different potential
PV technologies: monocrystalline silicon (mono c-Si), polycrystalline silicon (poly c-Si) and
copper indium gallium selenide (CIGS). Additionally, for two highways a study of the traffic
shading has been conducted and insightful information about the evaluation of traffic impact
on solar roads output has been provided. Highways have been selected for this first research
project due to the wide data availability. However, the same method can be applied to many
other roads category.

The solar road map could serve for advisory and counselling of both the private industry
and the government for future projects related to solar roads. The map is a useful tool for rec-
ognizing the optimal sites in terms of irradiation, traffic shading and the optimal technology
in terms of DC output and costs. Additionally, the study provides a general overview of the
feasibility of solar roads in the Netherlands and discloses the potential of this revolutionary
technology.

1.2. Research objectives

The objective of this research project can be summarized in the following three points:

1. Development of a method to estimate the irradiation and DC yield of solar highways in
the Netherlands: this objective will be achieved by modifying an existing irradiation
and DC yield model for conventional PV systems to adapt it for solar roads simulation.
This includes improving the accuracy of low altitude irradiation simulation, applying a
more appropriate temperature model and introducing traffic shading. In the report the
following research questions related to the methodology are answered:

(a) How can roads be localized in the LiDAR data?

(b) How can further correction factors be implemented in the irradiation model and
what is the improvement achieved in terms of accuracy?

(c) How can the irradiation and DC yield model be adapted to solar road technology
simulation?

(d) How can the model account for traffic shading?

2. Evaluation of the model sensitivity: the resolution of input data is tuned to analyze the
deviation of the model results. Knowing the sensitivity of the model allows the method to
be applied in situations when less data or computational power is available. In the report
the following research questions related to the sensitivity of the model are answered:
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(a) What is the loss of accuracy in the results if the azimuth resolution of the skyline
profile is reduced?

(b) What is the potential gain in computational time?

(c) What is the loss of accuracy in the results if the relative density between the ana-
lyzed points is reduced?

3. Evaluation of the irradiation and DC yield potential of solar highways in the Netherlands:
the model will be used to generate a map of the irradiation and DC yield potential of
solar highways in the Netherlands, using GIS software. The information stored in the
map will not only used to evaluate the potential of solar highways in different locations
but also study how the surrounding affects the system output, for example, to analyze
the actual impact of traffic on solar road irradiation and DC yield. In the report the
following research questions related to the model outputs are answered:

(a) What are the statistics (average, maximum, minimum and standard deviation) of
annual irradiation potential for solar highways in the Netherlands?

(b) What are the statistics (average, maximum, minimum and standard deviation) of
annual DC yield potential for solar highways in the Netherlands?

(c) What is the total DC yield potentially achievable with solar highways in the Nether-
lands?

(d) What is the impact of traffic shading on the potential of solar highways in the
Netherlands?

1.3. Report outline

Chapter 2 first gives an introduction about solar road technology and the state-of-the-art.
It follows an explanation of the basic principles of PV system modelling with a focus on
modelling methods for irradiation. The approach chosen for the research is then introduced,
mentioning the reasons that make this method the most suitable for the purpose of the
project.

Chapter 3 deepen into the modelling methods. The data used and the model inputs are
further described. A sensitivity analysis of the approach is conducted, based on the model
inputs, considering the possibility of limited data quality or computational power. Eventually,
the developed method is validated, comparing the obtained results with the data measured
at the existing TNO SolaRoad infrastructure in Krommenie, Amsterdam.

Chapter 4 focuses on the main changes made to the model in order to account for traffic
shading and module temperature in a solar road. The traffic shading model is then applied
to two the highways A12 and A16.

Chapter 5 the model results are reported. Different examples and case studies are con-
ducted in order to evaluate the irradiation and DC yield model, evaluate the potential func-
tion of the map and compare the results with the output of conventional PV systems. The
generated maps of irradiation and DC yield potential for solar highways in the Netherlands
are depicted. The effect of traffic shading is analyzed and discussed, using two explanatory
examples.

Chapter 6 summarizes the conclusions drawn and gives an overview of the research find-
ings. Eventually, in Chapter 7 recommendations are provided for the continuation and im-
provement of the research.






Theoretical background

In this chapter, a brief history of methods to harvest energy from roads is given and some of
the main designs studied or realized until now are briefly described. It follows an introduction
about PV system modelling with a more in-depth description of the approach chosen for the
purpose of this research.

2.1. Technology background

2.1.1. Insight in photovoltaic power conversion
To fully understand some concepts at the base of the research project here reported, an
insight into some definitions related to photovoltaic (PV) systems is necessary:

* The working principle of solar cells is based on the so-called photoelectric effect, which
consists of the generation of electrons from a material that has absorbed photons with an
energy above a material-specific threshold. This causes the photovoltaic effect, which
generates a potential difference at the junction of two different materials exposed to
electromagnetic radiation.

* The term irradiance, often indicated with a capital I, refers to the power density at a
certain point of the surface and is usually given in [W/m?]. In this report, a capital G is
used to indicate irradiance values.

* The above term should not be mistaken for the term irradiation, which is misleadingly
often indicated with a capital I as well. This refers instead to the integration of the
irradiance on a surface for an interval of time and it is given in energy unit, usually in
[kWh/m?].

* When it is referred to the DC yield (output), it is meant the energy converted by a PV
system in direct current or before the inverter or power conditioning.

2.1.2. Harvesting energy from roads

The first idea to harvest the solar energy concentrated on road surface through a so-called
“solar asphalt” dates back to 1979 when its application has been seen in snow-melting sys-
tems in Switzerland (SERSO) [41]. One of the first Dutch projects related to solar energy
harvesting from road surfaces was carried in 1998. A pipework was invented that was able
to transport deep groundwater under the surface of a concrete road and harvest heat. The
project was very successful and could potentially provide heat or cool for 100 family houses
or equivalent in energy consumption for each road kilometre [33]. The project adopted the
solar collectors concept and implement it in a road surface: in summer, the fluid circulates in
the pipes beneath the road and collects heat. The heat is stored, for example in an insulated
tank. In winter, the fluid is reheated and pumped back in the pipes below the road surface
and can be used to defrost the street or to provide heating to the neighbouring buildings.

9
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(a) Solar road concept developed by the american start- (b) TNO SolaRoad concept, developed in 2011 and in-
up Solar Roadways in 2006 stalled in Krommenie, Amsterdam, as fist pilot project

Figure 2.1: First solar road concepts based on PV technology

This concept is also recognized as a valid solution for the so-called urban heat island effect
in cities since it decreases the temperature of roads and consequently the energy needed
for cooling the surrounding. Additionally, heat can be stored for the cold months, providing
clean energy [56].

After the Dutch Ministry of Transport announced the Road to the Future programme,
more projects related to innovation in road constructions started. Among them, also hy-
brid systems ideas arose, where not only thermal but also electric energy is harvested from
solar energy. Many projects recognized the potential of photovoltaic energy in street light-
ing. In [45] and [74], results showed that the solar-powered LED lighting system can be
economically valuable because shorter transmission line needs to be installed in comparison
with a grid-powered system. This reduces transmission losses and therefore the total power
consumption, but decreases also material requirements for copper cables. An economic anal-
ysis showed that the payback period for the investment was only 1.1 years longer for solar-
powered LEDs in comparison with grid powered LEDs [18]. A more innovative project, called
EC-fics (Energy Conversion in a fully-integrated-clean-system), developed an integrated sys-
tems of solar-energised thermos-couple panels, enclosed in the asphalted road, windmills
installed on top of light masts and photovoltaic panels installed on the top of a perimeter
noise-reducing biomass collector [33].

In [33], [53], [69] and many more, photovoltaic technologies are further included in the
road environment and installed on motorways noise barriers to provide energy for street light-
ing, signals and/or to the power grid. The first project was realized in Switzerland in 1989
and now the application of PV on noise barriers (PVNBs) has greatly increased all around Eu-
rope. After [51], central Europe could potentially provide 680 GWh per year (still only 0.02%
of the electricity generation in Europe in 2017 [7]), going hand in hand with the increasing
legislation on sound protection from motorways and railways.

What is revolutionary in PVNBs is that no additional land is required and installation
costs can be shared with the investment costs for the sound barrier. New technologies such
as bifacial modules or hydrogenated amorphous silicon (a-Si:H) could have a big potential in
this application, as confirmed in [31], where a bifacial PVNB was fabricated and tested.

However, all the solutions considered above are restricted to either thermal-energy or low-
power density electricity generation. These technologies cannot, therefore, be applied on a
large scale but can only supply in situ consumption [19]. The increasing demand of power
supply also along the roads, driven by the advent of EVs and the necessity of a transition of
the public transport to sustainable energy sources, brought the idea of more efficient use of
road surfaces.

In 2006 a U.S. start-up Solar Roadways started developing modular solar roads with in-
tegrated PV cells and LED sources (Figure 2.1a). The solar road is able to convert power and
to emit light in the form of road signage and street lines [62]. It also incorporates a heating
system in the surface layer that can adjust the road temperature. In a middle layer, the elec-
tronic components are encapsulated, such as microprocessors that control heating, LEDs,
sensors and communication circuit between them [62] [56].
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Figure 2.2: Wattay solar road concept developed by Colas in 2015. The thickness of the solar road modules is claimed to be
less than 1 cm.

A different concept has been launched by TNO in 2011 (Figure 2.1b. It was the first solar
road pilot project in the Netherlands, called SolaRoad, and consisted of a 70 m cycle path in
Krommenie, North-Holland, built with precast concrete block, upon which a polycrystalline
silicon module is installed [66]. The pilot project harvested a cumulative annual energy yield
of around 78 kWh/m? [19]. However, based on the best performing modules, the energy
yield expectation for the SolaRoad is set between 85 and 90 kWh/m?. This value is smaller
than the electricity yield obtained by other infrastructure integrated PV (IIPV) systems, but it
remains appealing because it makes use of the area with PV potential otherwise left unused.

In 2015 the French construction company Colas, in collaboration with the National Insti-
tute for Solar Energy, unveiled its innovative product Wattway (Figure 2.2). The technology
consists in modular PV cells encapsulated in a resin that can stand the weight of a truck with
less than 10 millimetres thickness. Different than the Roadways and the first TNO concept,
Wattway modules can be directly glued on the road surface. Therefore, it can be applied to
already existing roads without the need for additional civil work. A modular pack of Wattway
has a peak power of 345 W,, and show a conversion efficiency up to 15%. In 2016, the com-
pany started to launch many trials sections in France, but also worldwide, mainly on parking
slots, to test the first prototypes. Eventually, in December 2017, the first world’s solar road
was inaugurated in the French village of Tourouvre. It counts 1 km covered by 2,800 m?
Wattway modules and it is said to generate enough electricity to power up to 5,000 average
French households [70].

In their work, V. Prasanth et al. presented a study case of the highway A12, which con-
nects the Hague to Arnhem, where inductive EVs power charging together with renewable
energy generation is analyzed. Interesting part of this project is the double employment of
photovoltaic technologies: on the noise barriers and on the emergency lane. The latter is
built as TNO SolaRoad with an estimated conversion efficiency of 9,69%. In the result of the
modelled study case, it is observed that the photovoltaic modules installed on the acoustic-
walls do not convert enough power (less than 10% of the total energy output of solar energy
sources), while the SolaRoad contributes for the highest share of the hybrid system in spring
and summer, overtaken by wind power sources in autumn and winter [69].

Other promising uses of roads infrastructure for energy harvesting are roadside PV de-
ployment and Solar Arch. The idea of Solar Arc is to integrate PV panels into arches over
highways. In the work of Sharma and Harinarayana, the potential of two highways in India
has been analyzed, discovering that the Solar Arches can harvest around 80 kWh/m? every
year [18].
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Figure 2.3: Sketch of a TNO SolaRoad section

2.1.3. Solar roads design

The first issue that solar roads implementing photovoltaic technology face is the necessity of
innovative design since they need to meet requirements for both pavement structures and
photovoltaic modules. Roads surfaces need to support traffic load, rutting (caused by vehi-
cles tires), fatigue cracking, rainwater drainage flow and skid forces [16]. On the other hand,
photovoltaic modules require minimization of the solar cells shading, strong cells intercon-
nection, weatherproof structure and diodes to avoid reverse current [52]. Additionally, solar
roads need to be designed to withstand snow accumulation and removal, salt-based winter
road maintenance and freezing in cold regions, while overheating should be considered in
the hotter climates and at the same time they need to be modular and easy to maintain, have
a low weight to facilitate testing and installation and require readily available components
and materials to sink the costs [52]. Therefore, a new design needs to be studied to optimize
technology integration in the infrastructure.

Many projects mentioned in Section 2.1.2 consider the fabrication of a new building con-
cept that should replace the conventional asphalt road. In the Krommerie project, TNO built
its SolaRoad laying on the ground prefabricated elements. These are composed of a concrete
housing, that hosts (starting from the bottom) a damping layer, a bottom glass, the poly c-Si
solar cells, a top glass and a transparent anti-skid layer on the top [66] [19], as represented
in Figure 2.3.

In this design, the major variation from conventional rooftop PV panels design is the pres-
ence of the anti-skid layer, which provides adequate friction on the road surface, and the
damping layer, which protects the module from mechanical stress [19].

In [52] a new pavement design structure is studied to withstand high traffic load and
incorporate photovoltaic cells. Cantilevered glass panes, already very common in floors de-
sign, is suggested as a surface layer where vehicles can drive on. This consists of multiple
glass layers so that if one fails the others will still support the design load. Below it, an
optical layer of multiple fibreglass is placed and several cut-outs in the structure are used to
host the cells. Cell interconnection is also improved in resistance, replacing the traditional
thin-coated ribbon with an insulated wired.

However, it is not realistic to expect all the Dutch roads to be rebuilt as following the con-
struction procedure applied in the above-mentioned designs. What is instead more probable
to see, employed in the near future on a larger scale, is a PV technology that can be directly
applied on the asphalt surface.

In [16], two different prototypes of solar road elements are developed: a solar panel and
a solar pavement. The solar panel consists of three substructures. From the top to the
bottom: a transparent polycarbonate sheet (Plexiglas), rough enough to provide skid and
slipping resistance, monocrystalline silicon solar cells placed in a rubber layer, and eventu-
ally aluminium is used to keep the layers together. While the solar panel is thought to be
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Figure 2.4: Sketch of the concept applied in this project, inspired by the Wattway solar road technology

embedded in asphalt, the solar pavement needs an asphalt layer, upon which two rubber
layers are placed: the bottom one containing the electric system and the top one the solar
cells. On the top, a surface porous layer protects the cells and drain the water. The two solar
road solutions are tested for skid, loading and fatigue resistance, drainage, and power con-
version. The solar pavement performs better than the solar panel in all the structural tests,
but its power conversion efficiency (PCE) is more affected by the encapsulation method. In
fact, solar cells below a Plexiglas sheet (solar panel) showed a PCE reduction of 26%, while
cells under rubber layers (solar pavements) performed with a 50% lower efficiency [16]. Un-
fortunately, these design still do not meet all the requirements to be implemented in a road
construction project and further research is therefore needed. For this reason, in this re-
search a different usage of the technology is considered, assuming a concept closer to the
one used for Wattway.

In the solar road developed by Colas, each panel contains 15x15 cm? poly c-Si cells,
embedded in a multilayer substrate made of resins and polymers of 7 mm thick. This layer
has been studied to be translucent enough to allow sunlight to pass through, and resistant
enough to withstand heavy traffic. The surface meets the standard of skid-resistance of
conventional asphalt and has been filed in many patents.

Figure 2.4 shows a guess of how the technology could be represented, based on literature
research and informal exchange of information with the company.

It is beyond the scope of this research to evaluate the feasibility of this technical solution
and the detailed explanation of the choice of material and construction method.

2.1.4. Photovoltaic technology in solar roads

Besides the structural and electrical design of solar roads, the choice of the most suitable
photovoltaic technology also plays a crucial role. The options go from monocrystalline and
polycrystalline silicon cells to thin-film technology and more innovative solar cells [52].

No research about the implementation of different photovoltaic technologies in solar roads
can be found. Only in [19] a theoretical model is utilized to estimate the module identity fac-
tor (MIF) of polycrystalline silicon, monocrystalline silicon and CIGS. The model assumes
a system with the same composition, optical and thermal characteristics as the TNO So-
laRoad in Krommenie and evaluates its performance in different conditions of temperature
and irradiance.

The MIF is the proportion of actually available energy yield to the estimated one and can
be obtained by the ratio of energy yield considering varying efficiency on energy yield with
constant (rated) conversion efficiency. Consequently, the lower the MIF value, the lower the
technology performance due to thermally and irradiance losses.

Among the analysed technologies, CIGS technology shows the highest efficiency reduc-
tion in all the simulated locations, even if the thermal coefficient chosen was slightly better
than the one for polycrystalline silicon. This aspect of thin-film technology is confirmed also
in the study of [37], where it results that CIGS implementation for surfaces exposed to a
vast amount of irradiation is critical. According to [19] the best performing solution were
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Figure 2.5: TNO SolaRoad pilot site in Krommenie (July 2019)

monocrystalline cells, due to higher conversion efficiency and a better thermal coefficient.

2.1.5. Solar roads state of the art

The first SolaRoad pilot project was opened in 2014 on the bike road next to the N203, in
Krommenie (Figure 2.5). The SolaRoad section was initially 70 meters long and 1,7 meter
wide. However, during the pilot, multiple versions of the solar pavement have been added.
Different coating technologies, solar module designs and cell types have been tested. There-
fore the SolaRoad is now 90 meters long and 1,7 meter wide.

The SolaRoad, which is connected to the grid, was expected to deliver between 50 and
70 kWh/m?/y of energy yield. However, the system overperformed after the first year of
operation and 73 kWh/m?/y were produced. Two years after, 93 kWh/m?/y were achieved
by the improved version of the system. The application of thin-film modules in the last version
of the solar road delivered until now lower energy output of 41 kWh/m?/y.

With time, the yield decreased back into the expected range, due to transmittance losses
of the top layer. It has been observed that this layer can be strongly impacted by the weather
condition, which caused the delamination of the road structure in many points of the road
(Figure 2.6). However, an improved version has already been developed [63].

After the success of the first trial, many other projects started in the Netherlands and in
France. The latest ones are the 100 m bus lane and the 50 m parallel road in Spijkenisse
and Haarlemmermeer, respectively, both in the Netherlands. Opened on the 7th of March
2019, these projects represent the first application of the TNO SolaRoad technology under
heavy traffic conditions. The first observations revealed damages to the road surfaces and
deformations after a week after the opening. These were probably caused by stresses of heavy
traffic [63]. Based on these results, the following projects will take a step back to light traffic
in order to further improve the technology.

In these terms, the story of Wattways can provide a better insight into the application of
solar roads in vehicles traffic conditions. Starting from October 2015, already more than 40
trial sites have seen the Wattway solar road technology being applied not only in France but
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Figure 2.6: Soiling and delamination of the top layer occurred in the SolaRoad pilot site in Krommenie (July 2019)

Figure 2.7: The Wattway pilot route in Tourouvre-au-Perche, Normandy, France (Photograph: Christophe Petit Tesson/EPA)

worldwide in order to test the technology in real conditions. The most relevant is the first
installation in the town of Tourouvre, Figure 2.7, where in December 2016, 1 km of a road
lane has been covered with 2,800 m? of Wattway PV modules.

The initial forecasts foresaw 790 kWh/d (103 kWh/y/m?) of energy conversion, enough
to power the demand of 3-5,000 people. However, after the first year, the effective energy
output resulted to be only 50% of the expected one (149,459 kWh/y or 53 kWh/y/m?) and
in the second year it dropped to 25% (78,397 KWh/y or 28 kWh/y/m?). In July 2019, the
cumulative energy generated accounts for 37,900 kWh [17].

In the Netherlands, another trial has been conducted by BAM Infra on the N401 near
Kockengen, in the region of Utrecht. A 20 m lane with an area of 50 m? has been covered
with 48 Wattway modules in May 2018. The test should have run for 2 years, but BAM Infra
decided to end the test after the first year, after having collected enough information. In this
year of trial, the electricity output resulted to be 2,200 kWh/y (44 kWh/y/m?) [28].

A better result for the solar road technology has been reported in the site of Ecommoy,
a village in Pays de la Loire region, France. Inaugurated on June 2018, the solar road was
designed to meet 30 % of the electricity need of the town hall and to supply power to the
electric vehicles for car-sharing. Since April 2018, the road has generated 3720 kWh (77.5
kWh/m?/y) and the goal has been almost reached. In fact, Wattway was able to supply one-
fourth of the town hall consumption and providing electricity for the EV charging station.
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Besides energy conversion efficiency, other characteristics of the Wattway technology have
been analyzed. Through camera research, the reaction of the drivers has been observed
and no abnormal behaviour has been registered by cars driving on the solar road section.
However, the module pavement has been found to increase the noise generated by traffic
of about 1.3 dB(A) . The consideration of this aspect will be decisive in case of application
in urban environments. In addition to that, it has been measured as a decrease in skid
resistance with time. The road surface became smoother, reducing vehicles grip. This aspect
is of great importance to ensure road safety and accounts for one of the reasons why the
duration of the trial has been shortened. Another issue is the wear out of the coating layer
after winter.

Giving a brief look at the involved costs, solar roads are still far from being competitive
with conventional modules. The Wattway pilot project needed a € 5 million state subsidy to
be realized, not considering the costs for past and still ongoing R&D. Solar road costs about
17€/kW in comparison with 1.3€/kW for a traditional solar installation [57]. Nevertheless,
the company aims to make the technology price comparable with conventional modules,
eventually (Personal communication by Pierre Trotobas, July 2019 at Intersolar Munich,
Munich, Germany).

To recap, to the solar road technology has been recognized a great potential but it still
needs to be further developed and tested for use on busy motorways. Additionally, the cost
of materials and fabrication will need to considerably drop in order to be competitive in the
market and for the technology to show a short payback time. In the future, Wattway by Colas
will focus on improving the robustness and the conversion efficiency of their product.

However, Etienne Gaudin, managing director at Wattway, underlines that the choice of the
location is critical when installing solar roads. Since it is not possible to adjust the module
to the optimal tilt and orientation, an accurate study of the most suitable location needs to
be conducted. The production of Wattway modules has been observed to vary from 40 to
120 kWh/y/m? in different sites. At this point, this research becomes an important tool for
companies and for the government to conduct a preliminary study of potential sites for solar
roads in the Netherlands.

2.2. PV system modelling background

2.2.1. Conventional modelling of irradiation and power output

With the development of building added photovoltaics (BAPV) and successively I[IPV, numer-
ous software tools and models have been developed to estimate the solar irradiation and en-
ergy output potential not only on roofs, but also of facades, and many other urban surfaces.
To give an insight into conventional PV system modelling approaches, the most relevant input
and equations are here summarized.

The first variable that influences the output of a PV system is undoubtedly the weather
conditions, which limit the solar irradiance of a specific location. The irradiance is defined
as the power density of the incident light at a certain point of a surface, measured in [W/m?]
[20]. The total solar irradiance, commonly addressed as global horizontal (GHI), is generally
divided into two components: the direct normal (DNI) and the diffuse horizontal irradiance
(DHI).

The DNI indicates the direct beam of the sunlight. With beam, it is meant a 5° field of view
concentric around the Sun [58]. It is normally measured with a pyrheliometer, an instrument
with a cylindrical shape that follows the sun with a solar tracking system to measure the
direct beam solar irradiance. From a narrow window, the light enters the instrument, where
commonly a thermopile converts the heat into an electrical signal and later into W/m?.

The GHI is instead the amount of irradiance that reaches a horizontal surface. The most
common instrument to measure it is the pyranometer, which has a hemispherical measure-
ment angle. The response of a pyranometer is directly proportional with the cosine of the
light beam incident angle. If it cannot be measured, the GHI can be indirectly obtained from
the other irradiance components, as explained in Equation 2.1:

"An increase of 1.3 dB(A) means that the final value is 101-3/1° or 1.35 times larger than the initial one.
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GHI = DHI + DNI * cos(6) (2.1)

where 6, the zenith angle, defined as the angular distance between the zenith and the sun
position in the projected skydome. Eventually, the DHI is defined as the irradiance on a
horizontal terrestrial surface that has been scattered or diffused in the atmosphere. It can
be measured with a pyranometer where the direct light beam is artificially blocked.

Another important aspect to consider about light is its spectrum. This is influenced by
several atmospheric factors and, among them, water vapour and CO, are recognized to have
the largest absorption bands. This means that a concentration of these two molecules vari-
ates the spectral component of the incident light on the module. In extreme conditions, this
can affect the conversion efficiency of the system.

Air temperature needs to be considered in a PV system model since the ambient air,
through convective heat exchange, tends to cool down the modules, positively impacting on
their performance. Wind speed, precipitation and air pressure are also commonly included
in a PV system thermal model.

To model the actual irradiance that reaches the plane of array (POA), diverse methods are
applied to the different components. They are depicted in a simplified manner in Figure 2.8.

Figure 2.8: Irradiance components on a POA

The POA direct beam, hereafter referred to as G§", is obtained from the DNI and the angle
of incidence (Aol). A shading factor (SF) can be also implemented as shown in Equation 2.2.
It takes into consideration the surrounding objects and varies from O when the sun is shaded
by an obstacle on the horizon to 1 when there is no shading.

G&™ = DNI * cos(Aol) * SF (2.2)

The Aol depends on the altitude (as) and azimuth (Ag) of the Sun (the position of the Sun in
the projected sky dome), and on the module orientation (4,,) and tilt (6y). It can be obtained
as shown in Equation 2.3 and illustrated in Figure 2.9.

cos(Aol) = cos(ay) * cos(as) * cos(Ay — As) + sin(ay) * sin(as) (2.3)

where a,; and A, are the coordinates of the module normal direction projected in the sky-
dome, and a,;=90°-6,,.

The POA ground reflected irradiance G%'* considers the reflectance of the surrounding
ground surface and the reduced incident light due to the module tilt, as expressed in Equation
2.4 and 2.5.

GHP = GHI x a x (1 — SVEy) (2.4)
1+ 6
SVFy, = y (2.5)

where «a is called albedo, the fraction of the GHI that is reflected by the ground, and SVFy is the
sky view factor (SVF) considering only the module tilt as reduction factor of the sky visibility,
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Figure 2.9: Angle of incident on a POA, with ny, the normal to the POA

which means in a so-called situation of free horizon. In a more realistic implementation of
the model, the SVF describes the complex skyline profile in a specific location. It varies from
0 when the surrounding objects completely cover the sky to 1 when there is a situation of
complete free horizon. Both of these two extreme values are less likely to be found in real
measurements. Therefore, the SVF mostly lies in between. In a different way than the SF,
the SVF does not depend on the time and the position of the sun but on the geometry of the
skyline solely. This factor will be discussed more in details in Section 3.4.

The POA diffuse irradiance G,'\ijf I can be further divided into an isotropic component (the
irradiance from the skydome), a circumsolar diffuse component (the scattered irradiance
concentrated immediately around the Sun) and a horizon brightening component. There are
several models that consider one or more of these components: the isotropic and the Sandia
sky diffuse model [58], and the Hay and Davies sky diffuse model [35], further implemented
in the Reindl model [25], where an additional term is accounted for the horizon brightening,
otherwise excluded. A different approach is followed by Perez [59] in a more complex model
that utilizes empirical coefficients instead of diversifying the three diffuse irradiance compo-
nents. Finally, shading of the array, soiling effect and increased reflection losses need to be
considered.

Most of the irradiation potential models are based on obtaining the hourly irradiance
received by the POA, taking into consideration the light intensity, its distribution in the sky
projection, the module tilt and orientation, and the skyline profile of the surrounding [30].
By integrating the hourly irradiance for one year, the annual irradiation is then obtained for
a specific location.

The models utilize the sun path projection and Digital Surface Models (DSM) to obtain
the shading profile of the objects that surround the examined point or surface through the
methods developed in [60], [39] and [40]. Additionally, meteorological data, observed with an
hourly frequency in the location are required in order to generate the decomposition model
with the main three components of solar irradiance. From the DHI and DNI values, the
transposition model generates the POA irradiance as a sum of the three contributions [20],
as it is shown in Equation 2.6:

GiPt = G + Gy + Gt (2.6)

The hourly irradiance values are then further inserted in a thermal and electrical model to
obtain the energy output potential. Thermal models go from a simple steady-state approach,
which considers the nominal operating cell temperature (NOCT) as constant in time, to the
Duffie-Beckman model until the more complex fluid dynamic model, based on a thermal en-
ergy balance between the module and the ambient temperature [20]. Electrical models mainly
consider the efficiency curve of the inverter. The Sandia National Laboratory developed an
empirical equation that models the relationship between the DC input and AC output of a
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PV system inverter [24].

As it can be noticed, this modelling approach consists of repetitive expensive calculations
and, nevertheless, a high amount of meteorological data from the installation site. These are
not always available and limit therefore the potential of PV system modelling. Additionally,
the wider the area that it is necessary to consider in the model, the more input data become
necessary.

In the particular case of research among solar road potential in the Netherlands, con-
sidered the extent of the studied surface and the heterogeneity of the national weather con-
ditions, a time and resource-efficient approach is determinant. When the model aims to
consider a wider area that is not a single location anymore, the above-mentioned approaches
become very inefficient. Therefore, a different modelling method has been considered for the
purpose of this research project.

2.2.2. Simplified irradiation model

In [13], a new modelling approach is developed by A. Calcabrini et al., based on the fact that
weather conditions are similar from one year to each other. Hence, it is reasonable to replace
weather data with climate data to estimate the annual irradiation on a POA. In fact, climate
data are obtained from a several years evaluation of weather data, which instead describe
the weather of a single year.

If the meteorological inputs are fixed, the irradiance of a surface is mainly dependent
on the surrounding shadowing obstacles. Hence, the simplified model obtains the annual
irradiation at a given location using only two indicators that depend on the skyline profile:
the sky view factor (SVF) and the sun coverage factor (SCF).

As already introduced, the SVF is defined as the ratio of the radiant flux collected by the
surface from the visible portion of the sky, to the one that the surface would receive in free
horizon conditions [36], i.e. it represents the portion of the sky in which the diffuse radiation
from the Sun is not blocked by surrounding objects or decreased by the module tilt itself, and
reaches the POA, approximated to its array’s central point [20]. The geometrical parameter
can be obtained from a projection of the skyline profile as explained further in Chapter 3.4.

However, a method solely based on SVF cannot offer meaningful results, since only the
diffuse isotropic and the ground reflected irradiance can be represented [61]. Therefore, it is
necessary to introduce a second factor. The SCF is defined in [13] as "the ratio between [the]
time that the sun is behind the module or blocked by the skyline per year and the annual
sunshine duration at the same location with a clear horizon”. This modelling approach differs
from the aforementioned ones because of this factor, as it is not based on irradiance input.
In fact, the SCF does not depend on the light intensity, but only on the amount of time that
the sun is actually covered by the skyline profile of the surrounding. The SCF becomes O if
the horizon is completely free from objects and 1 if the sky view is completely blocked. To
balance the accuracy loss of this method, the factor is very easy and fast to obtain by simply
comparing the skyline profile and the sun path projected on the same skydome.

In [13] the SVF and SCF are introduced in the irradiation model, respectively, by linear
and cubic functions. The correlation between these indicators and the annual irradiation
has been empirically obtained from simulations on both real and synthetic skyline profiles.
The annual sum of the simulated isotropic diffuse and albedo components, referred as I is
plotted against the corresponding skyline profiles’ SVFs, while the annual sum of the direct
and circumsolar components ;¢F is compared with the SCFs of the respective skyline profiles.
The coefficients that describe the curve fitting are valid for a specific module tilt angle and
orientation inside a definite climate region.

Eventually, the final annual irradiation Iy can be expressed in Equation 2.7 with the use
of these empirical coefficients cj,...,c5:

I, = BVF + I3¢F (2.7)

where,
BYF = (c4 + cs5 * agng) * SVF (2.8)
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3

JSCF = Z ¢+ (1— SCFY) (2.9)
i=1

Itis important to mention that the correlation coefficients do not include the ground albedo
®gna, Which can be introduced in Equation 2.8. The albedo coefficient is equal to O when the
ground surface is black, while it is 1 if the ground is completely reflective. Different values for
this coefficient were defined depending on the mounting ground material beneath the module
[58].

Additionally, from [13] it can be stated that when the sky view is completely obstructed the
estimated annual irradiation results to be zero, whereas, in a condition of the free horizon,
it is given by

4

IY(max) = Z Ci (2.10)

i=1

2.2.3. Simplified DC yield model

Once the annual irradiation potential of a system is known, its operative efficiency needs to
be calculated to obtain the annual DC yield output. The operative efficiency of a PV system
is generally lower than the conversion efficiency of the single module because it is affected
by module temperature and irradiance level.

Even if temperature and irradiance vary with time, the variation of the performance ratio
for PV systems generally remains below 10% throughout the year [14]. Therefore, the method
proposed for the irradiation model can be applied for a DC yield model as well. This results
in an annual DC yield output that can be obtained from Equation 2.11.

Ey = E5¢F + E5VF (2.11)
Where
EpVF = (dy + ds * agng) * SVF (2.12)
3
ESCF = z d; * (1 - SCFY) (2.13)

=1

The DC yield coefficients d,, .., ds are valid for a specific PV module type and tilt. This rep-
resents a limitation in the application of this model to generate an energy potential map in
urban areas, where the tilt angles and orientation significantly vary. Instead, this approach
results to be highly suitable for estimating the potential of solar roads, where the tilt angle
is approximated to be zero everywhere and one single module type is considered.



Methods for modelling irradiation and
power output

In this chapter, the modifications applied to the irradiation model, in order to improve its
results for the case of 0° tilted modules is presented. First, the model inputs are introduced
and described, then the methods to process the given inputs are explained. A sensitivity
analysis of the model, based on the input data resolution is conducted and the results are
presented. Eventually, a comparison with measured data at the TNO SolaRoad pilot project
in Krommenie is used to validate the irradiation model.

3.1. The analemma

The position of the Sun in the projected skydome throughout the year can be depicted in a
so-called analemma. It represents the position of the sun for each hour of the day, indicated
by azimuth and altitude, projected in a 90°x360° matrix.

In Figure 3.1 the analemma with a resolution of one hour is depicted. The analemma
shows the number of hours throughout the year in which the sun can be found in a certain
azimuth and altitude of the projected skydome. As the input of the irradiation model, the
analemma here represented will be further improved to increase the accuracy of the model.
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Figure 3.1: The cumulative time [h] in which the sun shines throughout the year
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3.1.1. The optical air mass correction factor
In [13], the author explicitly mentions that in the coefficients-based method “the SCF is not
an irradiance-weighted parameter - that is, blocking the sun one hour in the morning and
blocking the sun one hour at midday contribute in the same amount to reduce the SCF
value”. In some cases, this can cause a weak correlation with the hourly irradiation values.
One of the possible ways to improve this correlation is with the introduction of the concept
of optical air mass (AM), usually expressed in [kg/m?]. The AM is defined as the ratio of an
actual path length that the Sun has to travel through the Earth atmosphere to the minimal
possible distance, which is the case of the sunlight passing the atmosphere when the Sun is
at its zenith [20]. In this case, the optical air mass is called the air mass 1 (AM1). With the
variation of the angle 8, (defined as the difference between the zenith and the Sun altitude),
the AM can be obtained from Equation 3.1.

1
M := A
cos@ (3.1)

In order to correct the irradiation coefficients so that they consider the varying light in-
tensity throughout the day, the variation of solar radiation depending on Heart’s position
due to the presence of atmosphere needs to be included. The atmosphere is the limiting
factor for UV light to access the terrestrial surface. In fact, the atmosphere blocks most of
the photons with energy within the wavelength that defines UV light (approximately between
10 and 400 nm of wavelength). A photon crossing the atmosphere interacts with its matter
through mainly two processes: scattering and absorption. Which of the two processes ac-
tually take place, it depends on the wavelength of the photon/radiation and the size of the
interacting atmospheric particles [46]. These particles can be air molecules, but also dust
or aerosols. Especially, water vapour, oxygen, ozone and carbon dioxide are responsible for
absorbing short-wavelength radiation [20]. It is straightforward that if the sunlight needs
to travel through more atmosphere because it has a low altitude, then more photons will be
scattered or absorbed and will not reach the Earth’s surface.

In several publications, Christian A. Gueymard analyses different models that aim to sim-
ulate the extinction processes of light through the atmosphere. In [21] and [22], the author
individuates the presence of different optical masses that contributes to the extinction of
light in the atmosphere through absorption and scattering: the optical air mass, based on
the Rayleigh scattering, the water vapour, ozone and NO, optical air masses, based on the
absorption by the gas molecules, and eventually a mixed gas and aerosol optical masses. The
author investigates the broadband modelling method, which considers that the upper layers
of atmosphere contain NO, and O; that directly receive the extraterrestrial spectrum. In-
stead, the light that reaches the following layers is modified by the overlaying optical masses.

The AM model referred above in Equation 3.1 is highly simplified and it is not very appro-
priate for high zenith angles. In fact, at 8,=90°, the AM value tends to infinity, whereas the
path length of sunlight through the atmosphere clearly is not. Basically, the equation does
not take into consideration the sphericity of the Earth.

An empirical correction proposed by Gueymard in [22] considers the scattering of light
due to Earth’s curvature, as reported in Equation 3.2 and graphically represented in Figure
3.2.

-1
0.48353 - -095846

AM(6) =
(62) = |cosbz + tog7a12 = 6,175

(3.2)

This correction of the AM value is not expected to have relevant effect in an urban envi-
ronment since the sunlight at high zenith angles (low sun altitudes) is mainly blocked by low
skyline profile objects. However, this equation is inserted into the model in order to improve
its performances in (almost) free horizon situations, which can be oftener encountered along
highways in the Netherlands.

Figure 3.3 depicts the AM in a projected sky matrix in which the x-axis represents the 360°
of azimuth and the y-axis the 90° of altitude (complementary to the zenith angle, ag=90°-6,).
The AM varies from 1 kg/m?, when ag equals 90°, to around 38 kg/m?, when ag reaches
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1
cos(8;)

Figure 3.2: Optical air mass simply calculated with the solar zenith angle, 6, and m, as modelled by Gueymard. The dark thick
line indicates the bending of the sunlight path due to atmospheric refraction (modified from [34])

0° (38.0868 after [38]). As it can be observed, the model here proposed does not reach the
last value of 38 kg/m? expected for AM(8;=90°). This is because the lowest value of the
matrix count for an altitude of 1°, which in the literature is found to be around 26 kg/m?
(26.2596 kg/m? after [38]), confirming the AM26.3 obtained with the Gueymard model at
as=1°. This imprecision at horizon level becomes irrelevant after the further implementation
of the correction factor based on the angle of incident of light, introduced in Chapter 3.1.2.
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Figure 3.3: AM in a projected sky matrix [kg/m?]

The SCF only considers the direct sunlight, as it is said in [13]: “it is easy to imagine a
case where the direct and circumsolar irradiation components cannot be estimated using the
sky view factor. [...] Therefore, to estimate the irradiation due to these other two components,
we introduce a new indicator: the sun coverage factor”.

In 1970, experiments conducted in the Mojave Desert of California disclosed a clear cor-
relation between direct irradiance and sun altitude. The irradiance intensity is observed to
reduce with decreasing as (or increasing ). This phenomenon is related to an increase of
optical air mass and therefore the increase of scattering and absorption of light beams in
the atmosphere. Following this physical concept, the irradiance of a point consequently in-
creases together with its altitude too. This because the direct sunlight needs to pass through
less atmosphere [48].

The relation between direct irradiance component, sun altitude and point elevation (only
within the first km of altitude) can be obtained with the empirical Equation 3.3, adapted from
[48].

I;(AM(t),h) = Iy - (1 — 1.4 - h) - e 0-357-AM(D*7° (3.3)
with I, the solar constant 1361 [W/m?] [20] and h the altitude of the point of observation [km].
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In the particular case of this project related to solar roads in the Netherlands, the location
elevation will be irrelevant. However, it may be useful for future application of the method in
different areas of the world.

All this considered, a correction factor f;, based on optical air mass is introduced in the
model. The factor is defined as the ratio of the actual direct beam at a specific point h and AM
to the direct beam at AM1, as expressed in Equation 3.4. This because the I;(AM1) indicates
the maximum direct irradiation that after passing the atmosphere can actually reach the
terrestrial surface. AM1 describes the situation of the Sun positioned at the zenith (ag=90°),
where the shortest possible path of atmosphere needs to be overcome (around 100 km).

fag = 14(AM(t))
AM T (AM1)

Figure 3.4 and 3.5 represent the correction factor based on AM and its effect on the
analemma respectively. As it can be observed, the effect of this correction is limited to the
first 15-20° of altitude. The impact of this correction will be therefore mainly observed in
(almost) free horizon conditions.

(3.4)

AM based correction factor
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Figure 3.4: The AM correction factor in a projected sky matrix

3.1.2. The Aol correction factor

As already presented in Equation 2.2, the direct irradiance on the POA is directly proportional
to the cosine of the Aol, expressed in Equation 2.3. This is commonly called the "cosine effect”
or "cosine law” and considers that when the altitude of the Sun is not aligned with the normal
to the POA, the direct beams that reach the module surface are reduced, proportionally to
the angle that quantifies this misalignment (the Aol). Figure 3.6 represents this effect and
shows that the solid angle, from which the sunbeams can reach the module surface, becomes
smaller with increasing Aol.

Hence, the correction factor f,,; can be obtained with the cosine of the Aol:

faor = c0s(By) - cos(87) + sin(By) - sin(8z) - cos(As — Ay) (3.5)

where 6, is the zenith angle (90°-a), Ay is the orientation of the module and Ag the sun
azimuth. Figure 3.7 and 3.8 represent the correction factor based on Aol and the final effect
on the analemma of the superposition of the AM and Aol correction factors, respectively.
From Equation 3.5, it can be stated that for modules with a tilt angle equal to zero, which
corresponds to the approximation considered in this report for solar roads, the correction
factor can be reduced to the single cosine of the zenith angle. As it can be observed also in
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Analemma corrected with the AM correction factor [hrs]

©
o

116

[0
o

114

~
o

112

(©2}
o

110

Altitude [°]
N w B (€]
o o o o

-
o

0 45 90 135 180 225 270 315 360
Azimuth [°]

Figure 3.5: Analemma adjusted with the AM correction factor [hrs]

30°

Figure 3.6: The Lambert’s cosine law: reduction of the direct beams depending on the angle of incidence [9]

Figure 3.7, this correction will significantly reduce the direct irradiance at altitudes up to 40-
50°. In Figure 3.8, it can be noticed how the product of the two correction factors strongly
reduces the amount of irradiation received by a solar road. In particular, the irradiation
coming from a sun altitude up to 10° is completely invisible for a PV module placed on a
horizontal surface.
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Aol based correction factor
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Figure 3.7: The Aol correction factor in a projected sky matrix
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Figure 3.8: Analemma adjusted with the AM and Aol correction factors [hrs]
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Figure 3.9: Irradiation map of the Netherlands (source: SolarGIS)

3.1.3. Generation of irradiation coefficients for solar roads

After having applied the improvements described in the previous sections, the irradiation
coefficients for solar roads in the Netherlands can be generated. To increase the accuracy
of the model, it is chosen to divide the Netherlands into two parts, the South-West and
the North-East. This is due to the fact that the country shows a variation of irradiation
potential moving from South-West to North-East, as it can be recognized in Figure 3.9. The
climate data of two cities within these sections, Delft (52.010000, 4.357000) and Leeuwarden
(53.202402, 5.795840) respectively, were used to generate the irradiation coefficients for the
area.

As in Equation 2.7 and already explained in Section 2.2.2, five coefficients are generated
that account for the different components of irradiance. Tables 3.1 and 3.2 report the ob-
tained coefficients. It can be noticed that, with an assumed 0° tilt angle, no ground reflectance
is considered. Therefore, the coefficient c5 results to be zero.

Table 3.1: Irradiation coefficients for South-West Netherlands

Oy c, c, c; Cy Cs Sum
[1 | [kW/m?] | [kW/m?] | [kW/m?] | [kW/m?] | [kW/m?] | [kW/m?]
0 549 147 -81 411 0 1026




28 3. Methods for modelling irradiation and power output

Table 3.2: Irradiation coefficients for North-East Netherlands

Oy (2 c, c; (A Cs Sum
[1 | [kW/m?] | [kW/m?] | [kW/m?] | [kW/m?] | [kW/m?] | [kW/m?]
0 482 257 -163 406 0 982

3.2. Input data

A more detailed description of the procedure of data processing that is applied in this project
can be found in the manual in Appendix F.

3.2.1. Highways of the Netherlands

The list of the national Dutch highways is provided by the Ministry of Infrastructure and Wa-
ter Management in https://www.rijkswaterstaat.nl/wegen/wegenoverzicht/index.
aspx. Out of 38 national highways, 36 of them are considered. For A35 and A37 no data are
available at the moment in which the study is conducted.

3.2.2. LiDAR data

As explained in Section 2.2.2, the two main inputs to obtain the yearly irradiation of se-
lected locations are the irradiation coefficients and the skyline profile, which describes the
surrounding objects projected on the POA. This is usually obtained with an HORIcatcher, a
device of Meteonorm which is able to capture a 360° image of the horizon using a fish-eye
lens.

However, if a vast area wants to be analyzed, this approach results to be very time con-
suming if not impracticable. A more feasible solution to obtain the skyline profile from the
side along the motorways of the entire Netherlands is instead the use of a digital surface
model (DSM). A DSM captures and represents the natural and built features on Earth’s sur-
face (differently than a terrain model or DTM, which only include bare Earth elevation data).
It could be considered as a 3D image of the natural and built environment of an area.

DSM r 'I

Figure 3.10: lllustration of the difference between DSM (above) and DTM(below)

These models are generated with a measurement system called LiDAR (Light Detecting
and Ranging) and are normally collected in a regional or national database. The Netherlands
provides the DSM of the entire country as Actueel Hoogtebestand Nederland (AHN) in an
online open-source dataset (pdok.n1). The data, represented in Figure 3.11, are the results
of a collaboration between the central government and the provinces.

LiDAR is an optical remote-sensing technique which implements a laser light beam to
sample the surface of Earth, collecting x,y,z measurements. As depicted in Figure 3.12, the
measurement is performed by a moving vehicle (usually an aircraft, helicopter or a car) where
a scanner system, a GPS and an inertial navigation system (INS) are incorporated. The latter
is used to measure roll, pitch, and heading of the LiDAR system.

Laser pulses are emitted from the scanner system, they reach the Earth surface and are
reflected back to the vehicle where they are collected. The time of return of the emitted beams
is then converted into a height model of the scanned area. For more detailed information
about how LiDAR data are collected, it is possible to refer to [1].

The improvement that the use of LIDAR data brings to the solution approach is straightfor-
ward. LiDAR data represent a good replacement for real-life measurement, providing urban
elevation profiles in a digital form. On the other hand, the accuracy and method of data


https://www.rijkswaterstaat.nl/wegen/wegenoverzicht/index.aspx
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pdok.nl
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Figure 3.11: Map of the Actueel Hoogtebestand Nederland [12]

Figure 3.12: Representation of LIDAR system measurement [1]
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(b) LiDAR DSM of aligned trees and cable lines along the TNO SolaRoad in Krommenie

Figure 3.13: Temperature variation of solar road modules simulated in Delft for one year

extraction still define some limits to the implementation of LiDAR data.

First of all, the data are likely to be outdated. The measurements are conducted on a
regular basis of some years. Hence, they will not represent changes in the urban or rural
landscape which instead varies in a shorter period of time. Additionally, a scan of the entire
national area takes more than one year. Therefore, data from different regions will also be
dated differently. The LiDAR data utilized in this project (AHN3) are the most recent ones
and were collected between 2014 and 2019 (AHN1 are dated 1997-2002 and AHN2 are dated
2007-2012). Appendix A shows the progress in LiDAR detection for AHN3 in the Netherlands.

Secondly, the resolution of the output data is limited. The most detailed images that can
be extracted from the online open-source represents the surface of the Netherlands in pixel
of 0.5 x 0.5 m?. This resolution is the one applied in the model presented here.

In the last instance, LiDAR data present some intrinsic errors. The most relevant one is
that they cannot represent vertical surfaces. This is due to the fact that the measurements
are taken from above the ground and therefore no information is given about the real shape of
the detected objects, which are simply seen as perpendicular walls. This does not represent
an issue in the majority of the cases, such as for buildings since the walls are perpendicular
to the ground. However, features like trees, bridges or even hanging cable lines and traffic
shields are represented as monolithic blocks with vertical walls. Figure 3.13 gives an idea
of how the 3D elevation model from LiDAR data represent a bridge, trees and transmission
cables.

This aspect of LiDAR data represents an obstacle when it comes to estimating the irradi-
ation potential of solar roads in the proximity of these objects. For instance, if it is desired to
evaluate the potential of a solar road collocated close to an underpass, the irradiance com-
ing from below the bridge cannot be evaluated with the method presented above, since the
LiDAR data itself represent the sides of the bridge as a wall standing perpendicularly from
the ground.

3.2.3. Road maps

LiDAR data represent the surface area but do not give any additional information about the
detected items. It is therefore impossible to recognize the different objects, if not for the user
to visually identify them. Basically, the user can recognize from the LiDAR image where a
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Figure 3.14: Map of the Hectopunten of the Netherlands

road is collocated, but the software cannot apply the same method, if not with a complex
machine learning approach. Assuming that this technology is not available - which is true
for the majority of the cases - it is necessary to collocate highways in the LiDAR data using
coordinates of a geographic system. Again, if a vast area wants to be analyzed, a manual
work results to be very time consuming and inaccurate.

The solution that is found in this research project is the superposition of the LiDAR images
with the Nationaal Wegenbestand (NWB) map, represented in Figure 3.14. The NWB is a
dataset of the governmental open-source pdok.nl which illustrates the entire road network
of the Netherlands.

The coordinates of highway location markers are used to represent the roads routes. In
fact, each point of the map corresponds to a so-called hecto-point. This is a location marked
along a road each 100 m (the word comes from the SI prefix "hecto-”, meaning "hundred”),
starting from its relative begin until its end, building the so-called hectometration of a road.
While not all of these hecto points correspond to a physical sign along the road, it is true that
they never exist in isolation, but always in a contiguous series of points connected by means
of a constant distance. Also, each lane of a road is provided with its own hectometration.

The use of this map reveals to be advantageous for the scope of this project for two main
reasons. First of all, this map allows to georeference' roads in LiDAR data. Secondly, the
hecto-points provide regularly distributed points along roads width and length, which permits
to conduct a sensitivity analysis of the model by increasing or reducing their relative distance.

3.3. Calculation of the skyline profile

The skyline profile consists of a projected 360° image of the objects that surround the module
site. In order to extract this from the LiDAR data of the analyzed area, the approach described
in the work of Keijzer [43] is used.

To apply the model to this research project, it is necessary to introduce a link between the
LiDAR image loaded in MATLAB and the geographical coordinate system of the points to be
analyzed. Known the coordinates of the LiDAR image vertices (these can be extracted with
the MATLAB function geotiffread), it is possible for example to obtain the point x coordinates
Xpoints on the LiDAR image as

XRD — Xmi ,LIDAR
Xpoints = dr;l(m . (3.6)

"It means that the internal coordinate system of a map or image can be related to geographic coordinates system.
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Figure 3.15: Example of the skyline profiles extracted from two points along the A1 (127.384, 483.924 and 128.151, 483.138)

where Xpp is the x-coordinate of the points in the RD Amersfoort geographical coordinate
system?, XminLipar is the x-coordinate of the South-West corner of the LiDAR image where
the points are found, and dX is the LiDAR data resolution, in this case, 0.5 m. The model
can now extract the skyline profile of the surrounding of any point whose coordinates are
provided and many points can be given as input in one time. Figure 3.15 gives two examples
of how the results look like.

3.4. Calculation of the sky view factor

In a condition of free horizon, the SVF depends solely on the module tilt angle 8,, and can be
obtained with Equation 3.7.

1+ cos(6y)

(3.7)

However, in the majority of the cases, a raised horizon is present and in the calculation
of the SVF the location-specific skyline profile must be considered. In [64], a method is
developed to obtain the SVF from skyline 2D projections from fisheye-lens images. The image
is first divided into a raster, which in this work presents a 360 x 90 dimension (one value
for each 1° of altitude and azimuth). For each of the generated rectangular sectors, the
contribution to the SVF value is obtained from Equation 3.8.

- (i—0.5) - (i—0.5)
2n ) - cos( 2n

) (3.8)

7-[ .
PD; = o - sin(
As it can be observed, ® depends on the amount of annular rings that are considered. As
already mentioned, in this work n=90 rings is taken. Eventually, the sum of all the sectors’
weight corresponds to the visible part of the sky, i.e. the SVF of the location. Since 360

“horizontal slices” are considered in this work, the SVF is obtained as expressed in Equation
3.9.

2National Triangle Coordinates (also known as RD coordinates ) are the coordinates used at national level in the Netherlands
as a basis for geographical indications and files, such as national topographic maps, cadastral maps, DSM etc.
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SVF=Z36O-N (3.9)
i=1

where N is the amount of free sky rectangular sections on the annular ring i.

For solar roads, it is assumed a module tilt angle of 0°, even if roads sections generally
show an inclination, but very small (below 5°). Due to this assumption, the influence of
the sky section that is not visible to the module surface due to the tilt angle is not further
considered in this work.

3.5. Calculation of the sun coverage factor

The SCF is a function of the altitude of the Sun (ag) and of the skyline profile (agp). Considering
the annual Sun path and approximating the Sun as a 1D point located in its geometrical
centre, the SCF is equal to 1 if the Sun is positioned on the skydome projection above the
horizon but behind a projected obstacle profile. In [13], its calculation is summarized in
Equations 4.5.

Lyear Xsp(As(D), as(t))

SCF = %ear Xea(@5(0) (3.10)
Where
Xsp(As(t),as(0)) =1 if 0 <ag(t) < agp(4s(t))
. (3.11)
=0 otherwise
Xpu(as(t) =1 if as(t) >0 (3.12)

=0 otherwise

3.6. Sensitivity analysis of the azimuth step angle

To analyze the impact that the precision of skyline profile extraction has on the irradiation
output, a sensitivity analysis based on the increase of the azimuth step angle is conducted.
The aim of this analysis is to evaluate the gain in computational time against the loss of
accuracy in the irradiation potential estimation of a point and eventually find the optimal
trade-off between the two aspects.

Instead of every 1°, the presence of obstacles is detected for every 2°, 5°, 10°, and 20°. The
obtained profiles were eventually interpolated into 90°x360° skyline projections. The results
were then evaluated in order to find the optimal azimuth step angle.

The analysis is applied to a sample of 496 points taken from a section of the A16, following
the here explained procedure:

1. the skyline profiles of the point sample is calculated with a 1° azimuth step angle;

2. for each point the skyline profile is again calculated with an azimuth step angle of 2°,
5°, 10°, and 20°%;

3. for each of the calculated skyline profiles the annual irradiation Irr is obtained;

4. the ratio of the Irry with X-degrees azimuth step angle on Irr obtained with 1° degree
step angle is calculated as

Dev = —— (3.13)

With Irry the irradiation calculated with an azimuth step angle of X°;

5. the standard deviation is obtained;
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Figure 3.16: Example of how the skyline profile changes by tuning the azimuth step angle

Figure 3.16 provides an example of how a skyline profile is affected by the increase of az-
imuth step angle, whereas Figure 3.17 shows the results of the sensitivity analysis. It can be
observed that by reducing the step angle, the maximum number of calculations necessary
when extracting the skyline profile decreases exponentially. However, this increases the per-
centage of deviation of the results from the reference values obtained with 1° azimuth step
angle in an almost linear correlation.
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Figure 3.17: Maximum number of calculations and deviation of the irradiation results from the reference model by increasing the
azimuth step angle

The optimal point is found at 5° azimuth step angle. This would lead to a reduction of 80%
of the number of calculations ® and a deviation below 2% in the irradiation values obtained.
Still, an azimuth step angle of 1° is kept in the model. The detailed results of the sensitivity
analysis for increased azimuth step angle can be found in Appendix B.



3.7. Sensitivity analysis of the road points density 35

1100

10000 = === === - ___

900 - 7

800 o

700 - 7
-G -‘Maximum peak

-©-Average irradiation ‘ ‘
600 ! !
1 10 20 50 100 200 500 1000

Relative points distance [m]

Irradiation [KWh/m?/y]
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Figure 3.19: Irradiation results deviation by increasing relative points distance

3.7. Sensitivity analysis of the road points density

There are over 1,600 km of highways in the Netherlands. It is straightforward to under-
stand that the points used as input data can only represent a limited amount of the above-
mentioned road surface, generating results with an inevitable margin of error.

The objective of the sensitivity analysis of points density is to estimate the accuracy of the
model and how the following parameters influence the model output:

* the density of points distribution along the road length
* the density of points distribution along the road width

In order to evaluate the model sensitivity, the following method is applied for 7.4 km and for
a cross-section of the A16:

1. the number of points is first adjusted along the road, varying the distance point-to-point
(from now on referred as relative points distance) from 1 to 10, 20, 50, 100, 200, 500
and 1000 m on the road length, and from 5 to 15 and 20 m on the road width;

2. the skyline profile is extracted from each of the obtained points;

3. the irradiation model is applied to each of the obtained points;

3In general, it can be stated that computational time and number of calculations are directly proportional. However, the actual
running time depends on the server used and, in the case of this model, also on the single skyline profile extracted.
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Figure 3.20: Location of the pyranometer mounted on the TNO SolaRoad in Krommenie

4. the average, maximum and minimum irradiation is calculated;
S. the deviation from the reference sample (relative points distance of 1 m) is reported as

Dev = w (3 14)
mean(Irr) ’

With Irry the irradiation vector for all the points contained in the road section analyzed
and with a relative distance of X m.

Figure 3.18 represents the results of mean and maximum irradiation obtained for the dif-
ferent relative points distances, while Figure 3.19 shows their relative deviation from the
reference values. The results of the sensitivity analysis are reported in details in Appendix
B.

As it can be observed, with the increase of the relative point distance, it is still possible
to represent the average and peak irradiation along the road with a deviation lower than 2%
from the reference case. However, after 100 m of relative distance, values start to vary more
largely and the deviation grows up to 2.2% in the case of average values and up to 4.8% for
peaks. This is due to the fact that the skyline profile does not follow any pattern and it is
rather random. Therefore, when the points are more densely distributed, more details about
specific points will be captured. If the points are rarer, it is more probable to miss peaks of
maximum and minimum irradiation.

The relative distance of 100 m at which the data are provided in the Hectopunten map
shows a 0.4% deviation from the reference average and a 1.6% deviation from the maxi-
mum reference values. This is considered a good balance between computational time and
accuracy of the results. The relative distance of 100 m is therefore kept in the model.

The variation of the distance between the points along the road’s width needed to be
changed manually and is therefore probably less accurate than the previous two analysis
performed. The results can be found in Appendix B. It seems not to indicate a logical pattern
in the variation of the density of the points along the width. A more accurate research should
be therefore conducted in order to deliver any useful information towards the improvement
of the model accuracy.

3.8. Validation

In order to validate the model, real data of annual irradiation are needed. Thanks to the
collaboration with TNO it is possible to use the real data measured of GHI on the site of the
TNO SolaRoad pilot project in Krommenie, Amsterdam. Figure 3.20 shows the pyranometer
situated on a 4 m high stand along the SolaRoad and its location in LiDAR data.

The irradiance measured every 5 minutes from the pyranometer is integrated for one year
to obtain a reference annual GHI for the location. This resulted to be 1034 kWh/m?/y.

Comparing the model results for the indicated location with the integrated irradiance
measured by the pyranometer, it is possible to evaluate the deviation of the model from real
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data. The estimated annual irradiation is of 1011 kWh/m?, with a deviation from real data
of 2.2%. This error can be further reduced if the component of artificial light is ignored from
the measured values. Simply reducing to almost zero the nocturnal irradiance value, caused
by artificial light, decreases the reference value to 1029 kWh/m?/y and the error to 1.7%.






Solar roads modelling

In this chapter, further aspects that are exclusive for solar road PV systems are explored.
The model to account for traffic shading in the final irradiation and DC yield output, together
with the real traffic input data, is here described in details. The case studies of A12 and A16
are introduced. In addition, the temperature model used to simulate the solar road mod-
ule temperature variation is explained. Eventually, a comparison between the temperature
output of the TNO SolaRoad and the assumed glueable technology is conducted.

4.1. Characteristics of solar roads modelling

1. Skyline profile

2. Traffic 3. Temperature

|

4. Soiling and haze 5. Feasibility (ex. noise, cost)

Figure 4.1: When modelling solar road systems, five main aspects should be considered: the shading caused by the elevated
skyline, the shading caused by vehicles, the output reduction due to operational temperature, the performance drop due to soiling
effect and variation of irradiance due to haze and pollution, and the feasibility of the installation. The latter includes considering
noise generation, costs, etc.

Some additional aspects that affect the output potential of the system need to be consid-
ered when modelling solar roads. Figure 4.1 aims to indicate the four most important groups
of aspects when it comes to modelling solar roads.

Rather different than conventional PV modules, a solar road can be completely shaded not
only when the sun light is blocked by the surrounding skyline profile, but also when a vehicle
is driving on it. Traffic represents one of the biggest concerns and critics for implementation
of solar roads, as it is claimed that the power could be substantially reduced by cars standing
in a traffic jam.

39
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By thinking about the dirtiness that can be found on busy urban roads, it can be under-
stood how the soiling effect is relevant when it comes to solar roads. Trash and other objects,
together with sand and soil can reduce the irradiance that reaches the module beneath the
road surface. In addition, vehicles also cause air pollution. A high concentration of particular
matter (PM) can not only scatter sunlight but also changes the light spectrum that reaches
the road surface. This can cause a reduction in PV cell conversion efficiency.

Due to their position close to the ground and surrounded by obstacles, roads do not
easily receive natural ventilation. However, they are still exposed to solar irradiation for the
entire day and they are mainly built with dark coloured materials, such as asphalt, which
absorb light in all its wavelengths. For these reasons, road surfaces can reach a very high
temperature and this can impact solar road power conversion efficiency, as well.

Last but not least, when designing solar road projects, not only irradiation and power
output potential are to be taken into consideration but also costs, which are the main driver
in terms of feasibility of a project. Solar roads can still show an important initial capital
investment and a long payback time. These aspects will likely improve with more research
and mass production in the future. However, solar roads need also to comply with strict road
regulations, in particular, noise limits in urban and residential areas. Conventional roads
are studied and built to reduce the vehicles passing noise and solar roads will need to do
the same. Otherwise, additional costs for noise abatement measures needs to be accounted,
such as the erection of noise barriers, the introduction of speed limits, etc.

In the model developed in this research project, traffic shading and temperature-dependent
conversion efficiency are included. Further suggestions regarding soiling and haze impact
on solar roads output power can be found in Chapter 7.

4.2. Traffic

In 2018, almost 11.3 million vehicles ' have been counted on the Dutch roads [3]. If we
consider an average speed of 60 km/h [49], assuming an average car density on the main
roads of 2000 vehicle/h, and approximating the length of a car to almost 5 m, it can be
estimated that roads are fully covered by car for around

Sm- = = 02— (4.1)

m 25m  weh '
02— 200020 . L R _ 10 4.2
“Veh h 3600s " (4.2)

of the time. If only highways are considered and the average speed is set at 90 km/h [49],
the estimated coverage time drops to 11% applying the same simple calculation. Both these
estimations are considered in the literature as well. Wattway by Colas claims that roads are
generally occupied by vehicles only 10% of the time [70] and in [57] it is stated that roads are
used by cars only 20% of the time.

This small numbers should encourage who is sceptical for solar roads applications. How-
ever, it needs to be taken into consideration that on specific locations the dynamic shading
caused by traffic could instead significantly affect the output of the area and therefore be a
relevant aspect when deciding whether to build a solar road or not.

4.2.1. Traffic shading model

In order to insert this location-specific aspect in the model, traffic data of Dutch highways are
needed. In July 2016, the department of Traffic & Planning of the Faculty of Civil Engineering
and Geosciences at TU Delft created a research lab called DiTTlab (Delft Integrated Traffic &
Travel Laboratory), where students, researchers and practitioners can work with traffic data
and simulation models. One of the successful projects involved the development of an open-
source online app called 'Urban Mobility Lab Demonstrator’ that provides accurate traffic
data for the whole Dutch road network. The access to this source can be found in [J].

"These counts generally do not distinguish between single vehicles. The same vehicle can, therefore, be counted more than
once.
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In the collected data set, vehicles flow q [veh/h] and speed u [km/h| are provided. The
values are measured by so-called vehicle loop detectors. The most common detectors are
based on inductive loop, as represented in Figure 4.2: a wire coiled in a circle below the road
surface detects the variation of the electric field when an object (in this case a vehicle) passes
over the loop. Installed in combination with axle sensors, vehicle detectors can, therefore,
register speed and flow of passing vehicles in a defined time interval.

Figure 4.2: Electrical wires of an inductive loop detector embedded in the road asphalt layer (Modified from [6])

The detectors are positioned along the road with an average distance of 500 m from each
other. From these sensors, raw data are collected. The research group of DiTTlab applied an
adaptive smoothing method (ASM) in order to further process raw data. Developed at the In-
stitute of Economics and Traffic of the Dresden University of Technology, the ASM is a method
used to obtain spatio-temporal information from incomplete traffic data. In fact, stationary
traffic detectors are often not homogeneously distributed along the road path. Additionally,
it is difficult to reconstruct traffic behaviour between two distant detectors. The ASM takes
into consideration that, with increasing traffic congestion, information propagates upstream,
while in free traffic it moves downstream. This is a useful application to reconstruct traffic
situations from incomplete data [67].

The values are eventually represented in matrices where the time of the day (from 2 am
to 11:30 pm) progresses along each row, and the hectometers along the road advance along
each column, as represented in the examples of a section of A16 in Figure 4.3a and Figure
4.3b. This means that drawing a horizontal line perpendicular to the y-axis, the variation of
vehicles’ speed throughout the day in a specific point of the road can be obtained. Similarly,
following a vertical line perpendicular to the x-axes discloses the different vehicle velocities
that are encountered in a specific moment of the day along different sections of the road.

In the figures, it can be observed that the vehicle speed is maintained constant around 100
km/h during the day along the road section. However, at 30 m distance from the beginning
of the line, the vehicles speed seems to increase. This can be due to different reasons, such
as an expansion of the road width or after a motorway exit, where the car density is reduced.

Regarding vehicles flow, it seems that the most influencing factor is the time of the day. In
fact, along the whole road section, it can be recognized a very low vehicles flow before 5:00, a
higher flow between 6:00 and 9:00, a constant flow of medium intensity until 15:30, where it
rises again until 18:00. This pattern can be attributed to the entrance and exit office hours
during the weekdays.

It can occur that for different reasons (technical, of data collection, of data processing)
data are missing. An example is given in Figure 4.3, between 10:30 and 11:30 pm in the last
meters of the road section, where both speed and flow of vehicles are reduced to zero due to
missing data.

In order to couple the traffic with the irradiation data, it is necessary to further elaborate
the row data collected by the detectors and filtered with the ASM. First of all, the flow and
speed data need to be expanded from 2,580 30sec/day (from 2:00 am to 11:30 pm) to 2,880
30sec/day (24 hours of data). This is done by inserting values equal to zero before and after
the actual data. This correction does not influence the quality of the results, since between
11:30 pm and 2:00 am of the following day no sunlight hits the road surface. This makes
the traffic data in these time intervals irrelevant for the purpose of this study.

Secondly, the resolution of the collected data needs to be reduced from 30 seconds to one
hour basis. This is achieved by averaging both speed and flow data within each hour of the
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day.

Eventually, for each speed and flow value, coordinates are needed to generate a geograph-
ical distribution of the data. To do so, the route is first described using the coordinates of the
hectometers along the road. The coordinates of the detectors are known and are put along
the described route and the raw data of vehicles speed and flow are extracted. However, they
do not represent a heterogeneous distribution of data along the route. Therefore, the ASM fil-
ter is applied to complete the missing data. The flow chart in Figure 4.4 gives a visualization
of what explained above.

Row data of
speed and flow
(500 m)

Loop
detectors

ASM filter
(200 m)

Return data
(output points)

Definition of the
route
(input points)

Coordinates
interpolation

Adjusted route
(200 m)

Figure 4.4: Obtaining geographical distribution and missing traffic data

Figure 4.5 explains in a graphical manner the concept of the model behind traffic shading.
A vehicle travels above a point, which can represent an infinitesimally small section of a solar
road module (Ax—0). The time that the car needs to completely surpass the point can be

defined as in Equation 4.3.
dveh + Ax
At = ——— 4.3
Where d,.p, is the length of the vehicle, here assumed to be 5 m, and u(t) is the travelling
speed of the vehicle at the moment ¢.

to=0 te
At

Ax

Figure 4.5: Visualization of At, defined as the time that a vehicle needs to completely surpass a point (here represented in the
blue rectangle for simplicity)

The cumulative time in which the point is shaded by passing vehicles (T¢operage) can be
estimated as in Equation 4.9.

Tcoverage =At-q(t) (4.4)

Where q(t) is the vehicles flow [veh/h] at the moment t. Teoperage is @ vector that represents
the amount of time for each hour of the day in which the point is shaded by passing vehicles.
Figures 4.6 to 4.8 depict in bar diagrams the vectors Tcoperqge, u(t) and q(t) of one point on
the A16, left line, on the 1st of June 2018. The same considerations taken above for 4.3b and
4.3a can be recognized in these bar charts. It can be seen that, at constant driving speed,
the shading factor is only affected by the traffic flow and follow its variation throughout the
24 hours. These conditions are expected to be often encountered in highways, where the
driving speed is more constant than on secondary roads. It can be therefore concluded that
the impact of traffic for solar highways will be more influenced by car flow, while solar roads
in secondary routes will be also strongly influenced by the reduced driving speed.
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Figure 4.6: Vehicles speed [km/h] - 1st of June 2018 (point taken from A16, left line)
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Figure 4.7: Vehicles flow [veh/h] - 1st of June 2018 (point taken from A16, left line)
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Figure 4.8: Coverage time [min] for each hour of the day - 1st of June 2018 (point taken from A16, left line)

The coverage time Tcoperqge Can be seen as a reduction of the time in which the sun is
shining on the point. However, the impact of the shading effect caused by a car passing
above the road surface varies with time. In fact, a car shading a point of the road surface at
noon will have a stronger impact on the reduction of the total daily irradiation if compared
with a car shading for the same time the same point in the evening. This is because the
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amount of irradiance blocked by the shading object is higher in the first case than in the
second. For this reason, the coverage time needs to be weighted depending on the moment
of the day and then deducted from the hours in which the sun shines in order to estimate
the effective irradiation that reaches the road surface.

Similarly, the coverage time of each hour of the year can be related to a specific position of
the sun in the skydome. Transforming the coverage time into a simil-analemma (from now on
called traffic shading matrix or trMat) allows adding weight to the factor. Figure 4.9 depicts
the traffic shading matrix for a point on the A16.

It is now possible to correct the sun analemma by subtracting the traffic shading matrix.
The corrected analemma does not refer anymore to the amount of time in which the sun is
shining. It represents instead the amount of time in which a specific point of the solar road,
actually sees the sun shining in each hour of the year. It basically indicates the effective
hours in which the point on the road surface receives sunlight, considering traffic shading.

Analemma of the traffic shading time [min/h]

Altitude []

45 90 135 180 225 270 315 360
Azimuth [°]

Figure 4.9: Cumulative time in minutes in which a selected point of the A16 is shaded due to traffic at each hour of the year

In order to correct the total irradiation of one point due to traffic shading, SCF and SVF
need to be adjusted. The SCF of Equation 3.11 can therefore be redefined as traffic coverage
factor (TCF) in Equation 4.6. The traffic coverage factor corresponds to the faction between

* the sum of the hours in which the sun is behind the elevated skyline (SCF),

* plus the time in which the sun is above the skyline profile but the point is shaded by
passing vehicles,

and the total amount of hours in which the sun is above the horizon.

Yyear Xsp+tr (As(D), as(t))

T e Xen(as (@) (4.5)
where
Xspser(As(®),as(®) =1 if 0 <ags(t) < agp(4s(t)) (4.6)
= lcoverage (As(t)' as(t)) otherwise )
XFH(as(t)) = 1 lf as(t) > 0 (47)

=0 otherwise

The SVF can be corrected to a traffic view factor (TVF) applying a shading factor due to
traffic f;;. This can be generated as the ratio between the corrected analemma that considers
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Figure 4.10: A16 highlighted in red [71] Figure 4.11: A12 highlighted in red [71]

the traffic shading, and the one that does not. The traffic shading coefficient will span from
0 in case the traffic completely blocks the sunlight on the road surface for the entire year, to
1 in case the point never occurs to be shaded by vehicles throughout the year.

_ sunMat — trMat 4.8)
fes = sunMat '

TVF = SVF - f,, (4.9)

where sunMat refers to the sun matrix, including the AM and Aol correction factors and the
skyline profile, while trMat describes the simil-analemma for the traffic shading.

Using the TVF and the TCF in Equation 2.8 and 2.9 respectively, allows to estimate the
irradiation and DC yield potential of a solar road, considering real traffic data.

4.2.2. Application to the case studies of A16 and A12

Despite the great potential availability of traffic data, it was not possible to apply real data
to all the national highways. This was mainly due to the large size of shared data and the
restriction in time to process them.

Nevertheless, the traffic shading model has been applied for the two case studies of the
motorway A16 and A12 in order to correct their effective irradiation potential and to observe
the effect of traffic on their energy output. According to a study of Statistics Netherlands
(Centraal Bureau voor de Statistiek, CBS), these motorways are within the top 5 busiest
roads in the entire country [2].

The position of the two highways in the national map can be seen in Figures 4.10 and
4.11. The highway A16 connects the city of Rotterdam with the Belgian border. From the
available traffic data, an average flow of 677 vehicles per hour has been recorded in 2018, as
depicted in Figure 4.12. The A12 goes from The Hague to the eastern German border. The
model counted an average of 713 with peaks of almost 2,300 vehicles per hour in 2018, as it
can be observed in Figure 4.13.

4.3. Temperature

Temperature influences the PV module performance in such a way that an increase in the
temperature of a solar cell leads to a slight increase of short circuit current, but a relevant
drop in open-circuit voltage, reducing significantly the conversion efficiency [20]. As already
mentioned, the temperature of a rooftop installed PV module is influenced by the irradiance
intensity on the array received from the Sun, the convective heat exchange with the environ-
ment in both the front and rear sides (dependent on the ambient temperature, wind speed
and more other aspects), the radiative emission from the top surface, and the conductive
heat transfer between the module and the mounting structure.

In the case of a solar road, the thermal behaviour of the module needs to be considered
differently. Since the cells are placed between an anti-skid layer and the asphalt, the cooling
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Figure 4.12: Vehicles per hour passing on the A16 throughout the year (data of 2018)
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On the other hand, the underneath soil absorbs the heat with high thermal inertia, playing
the role of heat sink [19]. Therefore, thermal models mentioned in Chapter 2.2.1 cannot be

effect of wind and surrounding air on the rear side does not take place in a solar road module.
directly applied to a solar road.

Figure 4.13: Vehicles per hour passing on the A12 throughout the year (data of 2018)

In [68], V. Kumaravel developed a thermal model to estimate the temperature of the solar
cells in the TNO SolaRoad concept. The model was built upon the fluid dynamic model of

In addition to the material intrinsic thermal properties (conductivity and capacity), the tem-

temperature gradient between the layers. This model has been adjusted for this research
project and applied to generate the DC yield coefficients for solar roads in the Netherlands.
perature of the solar road modules depends on the following factors:

M. Fuentes [42] with the integration of conductive heat exchange and the formation of the

4.3.1. Temperature model

Solar irradiance: The module receives heat from the Sun and this is absorbed depending
on the absorptivity of the module. The absorptivity f of the module depends on the reflectivity
r of its surface, the absorptivity of the above ASL a and the conversion efficiency 7, based on

Equation 4.10 [68].

(4.10)

A-r—a)-(1-mn)

B
In fact, the more light is reflected, the less reaches the module surface and the more light is

converted into electricity the less energy is available to heat up the module.

The result of 1 —r — a is the actual transmittance of the anti-skid layer. In [68], Kumar-

avel conducted an optical study of the effective ASL transmittance for the case of the TNO

and to vary only depending on the angle of incident.

2

SolaRoad. This is found to be isotropic

Since no similar experiment has been conducted for a different solar road technology so far,

it is assumed that the same values apply here.

In the case of this

The results of Kumaravel optical analysis are depicted in Table 4.1.
research project, it is chosen to approximate these values to a third-order function. In Figure

2|t is uniform for all the orientations.



48 4. Solar roads modelling

ASL effective transmittance

o
o

o
&

—2.1-107%- AoI® + 1.3 -107* - AoI?
—0.0026 - Aol +0.73

o ©
w »~

Effective ASL transmittance [-]
o
N

-©-Measured values
O Model fit

0 10 20 30 40 50 60 70 80 90
Aol [°]

©
S

0

Figure 4.14: Variation of the ASL transmittance depending on Aol. The full line represents the measured data and in dotted line
the adapted function.

4.14, the modelled values of the ASL effective transmittance are plotted for different Aol. The
approximation causes a maximum deviation of 9% from the interpolation of the measured
values.

Table 4.1: Effective transmittance of TNO SolaRoad ASL (Values from [68])

Aol Teff
0 | 0.73
30 | 0.70
45 | 0.63
60 | 0.58
75 | 0.45
90 0

Wind speed and ambient temperature: The wind and ambient temperature drive the
convective heat exchange between the solar road surface and the environment. Wind speed
results to be less relevant than for conventional rooftop modules since the wind shear loga-
rithmically increases with the altitude [47].

Since the wind speed is generally measured on a higher altitude than the ground level,
it needs to be corrected. The power-law used in many PV system modelling to correct wind
speed is inaccurate for heights above 60 m 2 [47] but may still be applied for conventional
rooftop applications. However, the error increases for solar roads, which are mainly placed at
ground level. Therefore, the logarithmic wind profile of Equation 4.11 is preferred to correct
wind speed data.

h
()

U(h) = U(hres) " —5, (4.11)
In(—%)

Zo

where U(h) is the wind speed at height h, h,.; is the height at which the wind speed U(h,.f)

has been measured, and z, is the so-called terrain or surface roughness length that indicates

the friction of the wind with the ground for different types of landscapes.

Figure 4.15 summarizes the heat exchange processes that take place within the solar
road layers. A one-dimensional heat transfer is considered since all the materials have low
thermal conductivity and because the dimensions of width and length are much bigger than

3The so-called blending height is the height above which the local terrain roughness does not affect wind speed anymore.
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Figure 4.15: Heat transfer within a section of the solar road

thickness. As it can be observed, the module itself receives energy from the solar irradiance
Gy which is partly reflected, partly converted into electricity and partly absorbed and con-
verted into heat. In the case of solar roads, the irradiance that reaches the module is the
one that has been already transmitted through the ASL and the front foil of encapsulation.
Additionally, the module heats up via conductive transferred heat from layers above and

below.

The ASL is the only layer subjected to convective, radiative and conductive heat transfer.

This results in
0 = Qirr + Qcona — Qconv — Qraa

where
Qirr =Gy
Qcona = E : (Tfoill — TasL)
Qconv = He - (Tast, — Tamp)
Qraa = Hsky “(Tast — Tsky)
With

Qirr the energy from the Sun irradiance on the POA

Qcona the conductive heat exchange between the ASL and the front foil
Q.onv the convective heat exchange between the ASL and the environment
Qrqq the radiative heat exchange between the ASL and the sky

A the thermal conductivity of the layers’ material

d,s; the thickness of the ASL

Troi11 the temperature of the front encapsulant

Tys;. the temperature of the ASL

Tamp the ambient temperature

Tsky the sky temperature

4.12)

(4.13)

(4.14)

(4.15)

(4.16)
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H. the convective heat transfer coefficient
Hgyy the heat transfer coefficient due to radiation from the sky

The signs used in the equations depend on the definition of the heat transfer direction. In
this case, a positive sign indicates an energy input in the layer, while a negative sign indicates
an energy output.

The heat transfer coefficients can be obtained from the profile of the ambient temperature,
the sky temperature and the emissivity of the module surface, as explained in detail in [42].
The sky temperature is dependent on the ambient temperature, following the concept that in
a cloudy day, the sky temperature will be closer to the ambient one, while in a perfectly clear
sky, it will be higher. Equation 4.17 from [42] has been adapted for the weather conditions
of the Netherlands. The average clearness index in the country is approximately 0.4 [8].
Therefore, it can be concluded that cloudiness or haziness decreases the difference between
ambient temperature and sky temperature in an average day of 50%, assuming that a clear
sky has an index of 0.9. This lead to define Ty, as

Tokey = 0.4+ (0.552 - T2 ) + 0.5 - Tapmp (4.17)

m

In the layers below the ASL, the thermal model is based on a steady-state energy balance
method explained in Figure 4.16. The solar road is subdivided into the different composing
elements and an energy balance is applied to each of them. The system is considered in
steady-state when energy inputs balance energy outputs, or when the rate of energy content
change is equal to zero.

Rate of heat Rate of heat Rate of heat Rate of change of
conduction from | s | conduction from | = | generation inside the energy content
layer above layer below the layer of the layer

Figure 4.16: Steady state energy balance equation of the solar road layers

The assumptions made for coefficients and thermal properties are listed in Table E.2,
Appendix E.

4.3.2. Generation of DC yield coefficients for solar roads

The temperature model described in Chapter 4.3 is applied in the DC yield model introduced
in Chapter 2.2.3 for three different PV technologies: mono c-Si, poly c-Si and CIGS, assuming
the technical specifications indicated in Table 4.2.

Table 4.2: Technical specifications of the three different PV technologies assumed as input in the temperature model

Mono c-Si | Poly c-Si | CIGS
Neff 20% 16% 10.5%
Voc [VIM?] | 45.3 44.7 45.3

In order for the results to be compared with the scarce literature, the modules parameters
correspond to the ones assumed in the work of A. Shekhar et al. [19], where the author
studied the implementation of three different PV technologies for SolaRoad. In the case of
this research project, the dimension of solar road modules is unknown and the estimation
of DC yield needs to be obtained in kWh/m?/y. Therefore, the following modifications in the
assumptions of Shekhar are made:

* to obtain the number of cells n.,;; in a square meter, 1 m? is divided by the area of the

cell A..y, so that
1

Acell

Neent = (4.18)
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* assuming that all the cells are connected in series, the V, of the module is replaced by
the Vyccen of the single PV cell multiplied by the number of cells per square meter, so
that

(4.19)

Voc = VOC,cell *Neell

assuming no voltage drop over the interconnections.

Table E.1 in Appendix C reports all the assumptions made for the different PV technologies.

Tables 4.3 and 4.4 report the obtained coefficients. In this case, as well, the Netherlands is
divided into the same two sections considered for irradiation coefficients, as already shown in
Figure 3.9. It can be noticed again that, with an assumed 0° tilt angle, no ground reflectance
is considered. Therefore, the coefficient ds results to be zero.

Table 4.3: DC yield coefficients for South-West Netherlands

PV Technology d; d, d; d, d; Sum
[0° Tilt] [kW/mZly] | [kKW/m?ly] | [kW/m?ly] | [kWIm?ly] | [kWIm?ly] | [kWImZly]

mono ¢-Si 108 33 -19 79 0 201

poly c-Si 86 27 -15 63 0 160

CIGS 56 18 -10 41 0 105

Table 4.4: DC yield coefficients for North-East Netherlands

PV Technology d, d, d; d, d Sum
] [kWIim?/y] | [kW/m?ly] | [kW/m?ly] | [kW/m?]y] | [kW/m?]y] | [kW/m?]y]

mono c-Si 94 56 -35 79 0 194

poly c-Si 74 46 -29 62 0 153

CIGS 48 30 -19 41 0 100

The column that indicates the sum of the coefficients reveals the maximum DC yield
output that can be expected by the PV module (0° tilt angle) and technology considered. It
can be observed that for the South-West part of the Netherlands, poly c-Si solar roads can
generate up to 160 kWh/m? in a year. The output can rise to 201 kWh/m? with a mono c-Si
or be limited to 105 kWh/m? if CIGS is implemented. The same analysis can be applied to
the North-East part of the Netherlands.

Table C.3 in Appendix C shows the coefficients generated by applying the DC yield model to
the technology of TNO SolaRoad. Figures 4.17a and 4.17b depict the variation of temperature
in Delft throughout the year for a glueable solar road and for a TNO SolaRoad poly c-Si
module, respectively.

In fact, the temperature deviation from STC reduces of around 2% the maximum DC yield
potential of the solar road technology, whereas for conventional modules the deviation is
generally assumed to be around 6% [20]. Further research into the properties of the materials
used need to be conducted to explain this difference in a satisfactory manner. However, it is
already known that the ground plays an important role as heat-sink.

It can be noticed that in the case of the TNO SolaRoad the module temperature fluctuates
more, reaching higher temperature (up to 60 °C) in comparison with the glueable solar road
technology. For this reason, the estimated annual DC yield output of the TNO SolaRoad
decreases about 8 kWh/m?, 6 kWh/m? and 3 kWh/m? for mono c-Si, poly c-Si and CIGS,
respectively, in respect to the assumed glueable solar road technology. The difference is not
considered relevant, but it seems from the results that the glueable solar road technology
is less responsive to ambient and soil temperature. Further research into how the tempera-
ture model performs when applied to the assumed technology need to be conducted. Since
the assumed glueable solar road technology is solely based on assumptions and literature re-
search, it is reasonable to think that in a real application its performance would result rather
different than the simulated one. However, one reason can also be that the assumed glue-
able technology is around 6 times thinner than the TNO SolaRoad. This could significantly
reduce the heat accumulation potential.
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Figure 4.17: Temperature variation of solar road modules simulated in Delft for one year

Figure 4.18: Location of the TNO SolaRoad in Krommenie, Amsterdam, represented in LIDAR. The green points indicate the six
analyzed sites.

4.4. Comparison with TNO SolaRoad model

As already mentioned, data availability about solar road performance is scarce, due to the fact
that not so many installations are actually available for monitoring, but also because data
are mainly held by private. For these reasons, it was very hard to find a suitable validation
case for the modified DC yield model.

Nevertheless, a comparison with the TNO SolaRoad simulation conducted by A. Shekhar
in [19], and already mentioned in Section 2.1.4, is made in order to evaluate the model results.
The six points along the TNO SolaRoad installation and indicated in Figure 4.18, are analyzed.
Their DC yield for the three different PV technologies (mono c-Si, poly c-Si and CIGS) is
calculated applying the TNO SolaRoad coefficients and compared with the values obtained
by the simulation conducted in the paper. Table 4.5 gives an overview of the comparison
results.

The deviation of the obtained DC yield values from the one indicated in the paper of A.
Shekhar varies from a minimum of 6% to a maximum of 17% for mono c-Si, from 7% to 23%
in the case of poly c-Si and from 5% to 28% if CIGS is considered.

It can be stated that the Shekhar’s model results always lie in the range of the DC yield
values calculated for the six points. In particular, results in Point 3 show to good correspond
with the literature. However, the exact location where the model was applied is not known.
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Table 4.5: Comparison between the DC yield results of the TNO SolaRoad model in [19] and the results obtained with TNO
SolaRoad DC yield coefficients. The points are numerated from left to roght. The * indicates the results of Point 6, which is at
the edge of the new section of the SolaRoad and it is therefore not representative for the comparison.

DC yield Shekhar’s | Point1 | Point2 | Point 3 | Point4 | Point 5 | Point 6 | Deviation
[kWh/m?ly] | model [%]

mono c-Si 142 154 163 114 149 154 179* 6-17 (24%)
poly c-Si 99 123 130 91 119 123 143~ 7-23 (35%)
CIGS 64 82 86 60 79 81 95* 5-28 (38%)

The paper only indicates the location of ’Krommenie” as reference for the location where the
model is applied. Therefore, it is difficult to compare the results, as they might be affected
by different skyline profiles.







Results and discussion

In this chapter, the improved model is applied in different locations to observe its sensitivity
to latitude and tilt angles. It follows the presentation of the results of the irradiation and DC
yield potential estimation for the Dutch highways network. Mean, maximum and minimum
values, together with standard deviation, are provided for the analyzed roads. The three most
irradiated highways are indicated and their DC yield output potential is provided. A closer
look is given at the A10, ring road of Amsterdam, where optimal and unsuitable locations
are both discussed in order to show the function of the irradiation map. A comparison with
the output of a conventional PV installation is provided as well. Eventually, the results of
the traffic shading model are presented. The average time in which solar road modules could
be covered by passing vehicles is estimated, together with the impact of irradiation and DC
yield potential of the road A12 and A16. Two examples of situations in which traffic can be
considered as a relevant shading source are also given.

5.1. The effects of the optical air mass correction factor

In absence of atmosphere, the distribution of solar radiation at the poles would almost be
the same as at other lower latitudes, only less continuous on an annual basis. The weather
and the amount of air that the sunlight needs to cross variegate the solar radiation received
on Earth mainly based on the location’s latitude [48]. In this report, the influence of optical
air mass on the coefficient-based irradiation model introduced in Chapter 2.2.2 are studied
on the Equations and theoretical knowledge explained in 3.1.1.

In addition to the two locations selected in the work of A. Calcabrini [13], Delft (The Nether-
lands) and Antofagasta (Chile), two other cities are considered, Reykjavik (Iceland) and Bata
(Equatorial Guinea). This is done in order to explore the sensitivity of the corrected model for
higher and lower latitudes, respectively. The coordinates, together with the average elevation
of the chosen locations are listed in Table 5.1 and are indicated on a world irradiation map
in Figure 5.1.

Table 5.1: Coordinates and average elevation of the analyzed locations

Delft Antofagasta Reykjavik Bata
Coordinates (WGS84) | 52.01,4.357 -23.433,-70.433 64.14,-21.948 1.852,9.774
Elevation [m] 0 154 15 4

For each of these cities, a comparison is conducted between the coefficients obtained with
the original model (where no AM correction factor is applied) and with the improved version.
The results of the analysis are shown in Figure 5.2 and the table with the values can be found
in the Appendix B, Table B.4.

From the results, it can be observed that applying a correction factor based on the optical
air mass improves the coefficients for low tilt angles. In particular, for higher latitudes (Delft
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Figure 5.1: Irradiation world map with the analyzed locations
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Figure 5.2: Improvement of accuracy in the model with implementation of the AM correction factor
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Figure 5.3: Analemma in the city of Bata (left) and Reykjavik (right)

and Reykjavik), the accuracy of the model stabilizes on a constant value around 0.99, whereas
in the original model it was linearly decreasing with the tilt angle. In the case of lower latitudes
(Antofagasta and Bata) the improvement of the model is less significant.

In general, the AM correction factor principally impacts on high latitude locations, im-
proving the accuracy of the model for low tilt angles. This is because not considering the AM
correction factor overestimates the radiation at high zenith angles (when the sun is low on
the horizon) in the original model. The conditions of high zenith angles for Sun altitudes are
more often in the case of Delft and Reykjavik since they are located at higher latitudes, as
it can be observed in Figure 5.3. In fact, due to the inclination of Earth axes, the Sun path
covers significantly more often lower altitudes in winter in comparison with summer. On the
other hand, Antofagasta and Bata do not show similar variations in sun altitude throughout
the year, since they are located close to the equator. Therefore, the overestimation of di-
rect sunlight at high zenith angles has a lower impact on the irradiation estimation at these
latitudes.

The same can be said for low module tilt angles. For a module placed horizontally on
the ground (0° tilt), the share on total POA irradiation is higher for the diffuse than for the
direct component. This is due to reflections and higher Aol. An overestimation of the DNI
reduces the accuracy of the total irradiation estimation for these modules. Introducing the
AM correction factor improves the correlation with real data.

It follows that, for lower latitude, the POA irradiation received by a 0° tilted module will be
more influenced by DNI than on higher latitudes. Therefore, the improvement of the model
is less relevant at lower latitudes for low tilt angles than at higher latitudes.

5.2. The effects of the optical Aol correction factor

The major improvement to the model accuracy is given by the Aol correction factor. After the
application of the Aol correction factor for 0° tilted modules, 98% of the results fell within 5%
of relative deviation from the simulated values. In comparison, the previous version of the
model was giving a 5% range of relative deviation for only 65% values. Figure 5.4 compares
the accuracy of the two model versions.

5.3. Solar road irradiation map of the Netherlands

First of all, an analysis of the SVF along the Dutch highways has been conducted to observe
the impact of the skyline profile on irradiation potential. Table C.1 in Appendix C reports the
statistics for all the analyzed roads. Overall, it can be stated that highways are generally in
almost free horizon conditions. On average, they show an SVF of 0.9 and maximum values
of 0.99 that can be found in all the analyzed roads. Minimum values close to O can be found
but are mainly correlated with distorted data (see Section 3.2.2). They account anyway for
a very small share of the measured points. As an example, in the case of A16, only 0.7%
of the points show an SVF lower than 0.1, while almost 65% of the points is found to have
an SVF larger than 0.9. Although A 65 does not cross significantly built-up areas, it shows
the lowest average SVF of 0.78. Figure 5.5a represents how this reduction of the sky view is
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Figure 5.4: Comparison of the relative standard deviation and coefficient of deviation for the original (a) and improved (b) version
of the irradiation model for 0° tilted modules (Images generated from the original model, kindly concessed by A. Calcabrini [13])

instead due to the trees aligned along the entire road. Figure 5.5b gives a comparison of a
0.9 SVF skyline profile.

The irradiation model explained in Chapter 2.2.2 has been applied to the Dutch highways,
using different irradiation coefficients for roads situated in the South-West and in the North-
East part of the country. Figure 5.6 shows the graphic results of the model, where the
simulations conducted every 100 meters length and 15 meters width are here interpolated.
As explained in the legend, the following rule is applied: the more irradiation a solar road
section receives, the closer to yellow it is represented. Irradiation maps classify the points in
five classes of annual irradiation applying the Jenks Natural Breaks classification method,
as represented in Figure C.1, in Appendix C. The method classifies the values in class breaks
that minimize the within-class variance and maximize the between-class difference. This
was chosen to allow a meaningful evaluation of optimal sites in terms of energy output and
discard values under a minimum range of interest.

The irradiation potential map of solar highways in the Netherlands can be provided in
digital version upon reasonable request with precise values for each analyzed locations.

Table C.2 in Appendix C gives the statistics of irradiation for each analyzed road. Overall,
the Dutch highways show an average irradiation potential of 882 kWh/m?/y and a maximum
peak on A73 of 1026 kWh/m?/y. The top three most irradiated highways are reported in
Table 5.2.

However, there are several locations in which the irradiation potential has been observed
to drop. From further analysis, it has been recognized that reduction of irradiation potential
is mainly caused by the following four factors:

* Underpassage at interchanges and bridges

¢ Tree-lined avenues
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Figure 5.5: Examples of skyline profiles along highways

e Urban environment (mainly buildings)

* Distorted data (traffic shields, cable lines, etc.)

The highway A10 around Amsterdam represents a good example to be further analyzed.
Assumed that the municipality already decided to launch a solar road trial along the ring
road, the map representing the irradiation potential of highway A10 is very useful at this
stage. Figure 5.7 depicts the irradiation of A10 and main injecting highways. The road
shows average irradiation of 881 kWh/m?/y, with a peak around 1022 kWh/m?/y in the
areas of Watergraafsmeer, Ringweg Oost.

The two areas circled in black on the map represent two underpasses, where the road
passes below the canal. Obviously, these two locations do not represent a considerable op-
tion. Another area where the construction of a solar road is not advised would be the section
indicated with the number 1. Figure 5.8a shows more in details that trees are planted along
the road in the interchange and that another road is intersecting the A10 in this stretch on a
bridge. These elements are the cause of shading of the road surface and decrease therefore
the irradiation potential in the area to an average of 670 kWh/m?/y and a minimum of 440
kWh/m?/y.
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Figure 5.6: Map of the irradiation potential for solar highways in the Netherlands
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Figure 5.7: Irradiation potential map of the A10 and main injecting highways
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Table 5.2: Top three highways in the Netherlands for annual average irradiation per m?

Road Average irradiation Description

[kWh/m?ly]
A31 1002 The road connects the A7 near Zurich to the A7 near Drachten
and mainly crosses cultivated lands
A5 999 The road was born as a by-pass for the city of Amsterdam to relieve
the surrounding motorways from traffic towards the capital.
Since the highway does not have any other aim than the city,
it crosses a free horizon countryside in the West of Amsterdam
A200 983 Crossing no built-up areas

On the other hand, the section indicated with number 2 represents an appealing location
for solar road testing. Figure 5.8b shows that the area is situated away from buildings or
other possible shading objects and also that the carriageway widens in the section, offer-
ing more irradiated surface. Section number 2 has an average irradiation potential of 940
kWh/m?/y (almost 30% higher than in section number 1) and reaches points of over 1020
kWh/m? /y, close to the maximal annual irradiation achievable in the South-West region of
the Netherlands (1026 kWh/m?/y).
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Figure 5.8: Details of the irradiation potential for the two analyzed sections of A10

5.4. Solar road DC yield map for the Netherlands

The DC yield model explained in Chapter 2.2.3 has been applied to the Dutch highways,
using the DC yield coefficients for roads situated in the South-West and in the North-East
part of the country. Similarly to the irradiation map previously represented, Figure 5.9 shows
the interpolated results of the DC yield model for poly c-Si solar road modules. As explained
in the legend, the following rule is applied: the higher the energy output of solar road section,
the closer to green it is represented. Similarly to the irradiation potential map, the Dc yield
map classifies the analyzed points using the Jenks Natural Breaks classification method, as
shown in Figure C.1. The map of DC yield potential of solar highways in the Netherlands can
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Table 5.3: Statistics of the DC yield potential of solar highways in the Netherlands

DC yield | mono c-Si poly c-Si CIGS
[kWh/m?2ly] | [kWh/m?ly] | [KWh/m?/y]
Average 173.93 138.53 90.11
Maximum 200.98 160.00 104.99
Minimum 0.07 0.05 0.03
StD 13.21 10.41 6.75

be provided in digital version upon reasonable request with precise values for each analyzed
locations.

Table 5.3 reports the statistics of DC yield output for the three different PV technologies.
For mono c-Si, Dutch highways show an average output of 173 kWh/m?/y and a maximum
peak of almost 201 kWh/m?/y in several sites. If poly c-Si is assumed, then the average
output decreases to almost 139 kWh/m?, with peaks of 160 kWh/m?/y in the best locations.
With CIGS, the annual DC yield is further reduced to an average of 90 kWh/m?/y and a
maximum value of 105 kWh/m?/y. Overall, mono c-Si shows a generation potential around
25% higher than poly c-Si, whereas CIGS DC yield is on average 35% lower than of poly c-Si.
This output was expected since the conversion efficiency of mono c-Si is approximately 25%
higher than the one assumed for poly c-Si, whereas CIGS has a conversion efficiency of about
34% lower.

Tables C.4, C.5 and C.6 in Appendix C report the statistics of the annual DC yield output
for each analyzed highway, assuming mono c-Si, poly c-Si and CIGS are provided. In the
last column, the total generated output is calculated assuming that the road is completely
covered by PV modules. The average DC yield is multiplied by the specific length of each road
with the assumption of 15 m road width.

According to this calculation, covering the three longest highways of the Netherlands A7,
A2 and A15 with solar road modules will generate almost 477, 404 and 401 GWh in a year.
However, this will require to cover 240, 212 and 204 km of road surface respectively. At this
stage of technology development, it is more reasonable to identify the three roads with the
highest average potential (irradiation): A31, A5 and A200. Table 5.4 shows their respective
average and total DC yield for the three different PV technologies. The total DC yield is again
used to indicate the case in which the road is completely covered by solar roads module. In
the case of A31, A5 and A200 this means a solar road of 65, 14 and 1 km respectively.

If the total surface of the Dutch highway network was covered by solar road modules, 5.2
TWh/y, 6.6 TWh/y, and 3.4 TWh/y of electricity could be generated in the case of poly c-Si,
mono c-Si and CIGS module technologies, respectively. The CBS reports a national electricity
consumption of 120 TWh in the year 2018 [4]. 3 to 5 % of the national consumption could
be therefore obtained by solar road installations in the Netherlands. If it is assumed that
15% of electricity is consumed due to street lighting, mono c-Si solar highways would then
be able to power up to 36% of the national consumption (28% and 18% in case poly c-Si and
CIGS modules are installed).

Table 5.4: Top three highways in the Netherlands for annual average DC yield output per m?

PV technology | DC yield A31 A5 A200

poly c-Si Average [kWh/m?/y] 157.3 156.8 154.3
Total [MWh/y] 153,367.5 32,928.0 2,313.9

mono c-Si Average [KWh/m?/y] 196.4 195.7 192.6
Total [MWh/y] 191,451.0 41,1054 2,888.3

CIGS Average [KWh/m?/y] 105.0 104.8 100.6

Total [MWh/y] 100,025.3 21,474.6 1,509.2

It is interesting to compare the model results with a conventional PV system installation.
South to the Technical University of Delft, along the A13, a virtual free-standing solar park of
6.9 MW,, has been simulated since 2014. Its performance can be checked on the Dutch PV
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Figure 5.9: DC yield potential map for solar highways in the Netherlands. Poly c-Si modules are assumed.
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Figure 5.10: Location of the PV system case study in the south of Delft and the A13 highways section passing nearby

portal established by the university (https://pvportal-2.ewi.tudelft.nl/). The system
consists of around 21 mono c-Si modules (high efficiency of 20.07%), distributed in 27,811
m?. In 2018, the system generated around 1,184 kWh/ kW, which can be converted into
8,168 MWh, with an average of 294 kWh/m?.

It is now assumed to cover the same ground area with poly c-Si solar roads modules along
the nearest section of the A13, as depicted in Figure 5.10. The annual DC yield output would
result in 3,803 MWh/y, with an average of 137 kWh/m?. This accounts for almost 47% of the
DC generated by the conventional system. If mono c-Si would be used, the average annual
DC yield would rise to 151 kWh/m?, reaching a generation of 4,199 MWh /y. This will account
for 51% of the output of the conventional PV installation. This means that to obtain the same
output as the one generated by the tilted conventional modules, a double large ground area
should be covered with solar road modules.

However, together with the spacial conversion efficiency, also the value of the occupied
land needs to be considered. In fact, the land occupied by the PV system is not available
anymore for example for agricultural purposes, such as growing potatoes.

According to the United Nations Food and Agricultural Organization (FAO), 4.57 kg/m?
of potatoes can be grown on average in the Netherlands. Assuming a reasonable retail price
of 1 € /kg, it is possible to earn 4.57 € each square meter of cultivated land. The area that
the PV system subtracts from cultivation also comprehends the row spacing between the
tilted modules in order to avoid mutual shading (an area that is saved in case of solar roads),
which accounts for 160,490 m?. Therefore, the total area occupied by the conventional PV
system would have generated annual revenue of 732,797 € /y. Selling electricity to neighbour
households at 0.17 € /kWh, would generate a revenue of 1,388,589 € /y. The net value of
earnings from the land used can be therefore considered to be the subtraction of the potential
food cultivation revenues from the electricity revenues. This accounts for 655,792 € /y.

The same calculation can be performed for the solar road. If mono c-Si modules were
installed, its annual electricity revenues would be 713,908 € /y. On the contrary than for
the field occupied by the conventional PV system, the area of the solar road would anyway
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not be available for other lucrative purposes. Therefore, the net earnings from the land used
simply accounts for 713,908 € /y.

Comparing the results, it can be observed how the solar road can actually generate rev-
enues of 58,116 € /y more in comparison with the conventional ground-mounted PV system.
If the comparison was conducted with a rooftop installation, the outcome of the conventional
system would have probably been better. However, in this case, surface constraints would
have also played a role.

5.5. The effect of traffic shading

The shading effect caused by traffic has been observed for both A16 and A12. Figure 5.11
indicates the interpolation of the cumulative traffic coverage hours obtained for every 200
meters along the A16. For the results of A12 and the irradiation map after the introduction
of traffic shading, it can be referred to the maps in Appendix D. The areas indicated in red
are the road sections most affected by traffic shading and are therefore the ones that show
the highest reduction of the annual irradiation potential. In general, the threshold of 350
h/y has been set as the value for high traffic shading.

The maps of traffic shading time, irradiation and DC yield after applying the effect of traffic
shading can be provided upon reasonable request with precise values for each analyzed lo-
cations. The map of traffic shading time classifies the points in five classes of traffic coverage
time of equal range. This was chosen because secondary aspects correlated to traffic, such
as haze, pollution and noise, are directly correlated to traffic intensity. In this way, a direct
correlation is easier to be applied to the different classes.

It needs to be taken into consideration that the right and the left lanes behave differently
since they show different traffic flows at a different time of the day. It is true that the car
that drives to the office along one lane, comes back after work on the other one. However,
it is also true that the two travels happen in a different moment of the day and therefore
affects differently the irradiation potential of the road surface. Additionally, more complex
behaviours and location-specific characteristics of the road also play a role in defining the
causes of traffic on each lane.

Tables 5.5 to 5.8 report the statistics of traffic coverage time, irradiation and DC yield
potential reduction along both A16 and A12. Overall, the annual average coverage time on
the A12 counts for around 240 hours, varying from a minimum of 120 to a maximum of 450
h/y. This means that for a cumulative amount of 240 hours within one year on average, a
point on the road is completely shaded due to traffic. This accounts for 2.7% of the hours in
ayear. For A16 the numbers are slightly slower, with an average coverage time of 230 hours
per year (2.6% of the hours in a year), varying from a minimum of 58 to a maximum of 416
h/y.

However, what is relevant in a study dedicated to solar roads is to understand how many
of these shaded hours happen at the same time as hours of sunlight. In fact, in case of
a traffic jam during sunset, the coverage time of the location will equally increase as if the
traffic jam occurs at noon but in the first case, the energy output of the location will be less
affected by traffic shading than in the second case.

On average, the annual irradiation and DC yield reduction caused by traffic has been
found to be around 3%. This is a considerable percentage, comparable with cables losses in
large PV installations and needs, therefore, to be taken into consideration.

Nevertheless, there are specific locations where the reduction rises over 5% for the irradi-
ation and to almost 9% for the DC yield and the threshold of 350 h/y of traffic shading time
is overcome. On the A12, these points are located in proximity to two very large interchanges
called in Dutch Knooppunt Lunetten and Knoppunt Velperbroek, located in the province of
Utrecht and in the region of Arnhem, respectively. It can be stated that interchanges always
attract high vehicles flows. Additionally, in the proximity of ramps', vehicles speed tends
to reduce and the number of lanes decreases as well, generating downstream congestion. A
similar effect can be observed at the exit of the highway, in the North of The Hague, where
the vehicles need to slow down. These phenomena have been observed to cause a reduction

A road that allows access to an interchange, also called slip road.
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Figure 5.11: Interpolated annual traffic shading hours for A16

Legend
Interpolated A16
Traffic coverage time [h/y]
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Table 5.5: Statistics of the effect of traffic shading on annual irradiation for left and right lane of A16

A16 Teoverage Y AIY Reduction
Irradiation [hty] [KWh/m2/y] | [KWh/m?/y] [%]
Average 233.24 895.70 26.17 2.9
Maximum 416.69 1013.39 57.34 6.1
Minimum 58.26 13.16 0.00 0.0
StD 56.56 133.97 8.47 1.0

Table 5.6: Statistics of the effect of traffic shading on annual DC yield for left and right lane of A16

A16 Teoverage EY AEY Reduction
DC yield [h/y] [kWh/m2/y] | [KWh/m?/y] [%]
Average 233.24 140.64 4.08 3.0
Maximum | 416.69 159.05 8.92 8.92
Minimum 58.26 2.02 0.00 0.00

StD 56.56 21.06 2.32 1.32

of received irradiation up to 50 kWh in a year.

In the case of A16, there are fewer points where the traffic coverage time surpasses the
350 h/y. In general, it can be observed that in the proximity of bridges the traffic shading
effect is more significant. This is due to the fact that bridges are points of convergence for
many roads that need to cross a water body.

Next subsections contain a more detailed analysis of two locations that count for partic-
ularly interesting and explanatory examples.

5.5.1. Example 1 - Knooppunt Lunetten (A12)

The interchange Knooppunt Lunetten is located in the South-East of Utrecht, close to the
residential area of Lunetten Zuid. It connects A12 with A27, generating a high flow of vehicles
every day. Figure 5.12 represents the interchange in an image generated from LiDAR data.
The left and right lane are indicated in red with the respective flow directions. The points
along the road indicate the traffic coverage time calculated every 200 m. As explained in
the legend, the following rule applies: the higher the traffic shading time, the closer to red
their filling colour, the higher is the cumulative time in a year in which the indicated point
is completely shaded by traffic.

As it can be observed in the figure, the area on the left lane that is leaving the interchange,
indicated with red and orange points, results to be the most affected by traffic shading. This
means that the shading is caused by car entering the road section through the ramp indicated
with a red line in the figure. As already mentioned, ramps (together with bridges, points in
which the number of lanes is reduced and many others) represent a point in which vehicles
tend to have a lower speed while accessing the highway. This tends to generate congestion
at the injection point. The phenomenon causes this section of the road to present a coverage
time from 340 up to 400 h/y and an annual irradiation reduction from 46 kWh/m?/y up to
50 kWh/m?/y (around 5%). The DC yield losses due to traffic account for up to 8 kWh/m?/y,
slightly more than 5% reduction of the total generation.

Table 5.7: Statistics of the effect of traffic shading on annual irradiation for left and right lane of A12

A12 Teoverage 1Y AIY Reduction
Irradiation [h/y] [KWh/m?2/y] | [KWh/m?2/y] [%]
Average 240.76 878.70 26.80 2.9
Maximum 448.91 997.57 52.24 54
Minimum 123.09 10.67 0.00 0.0
StD 47.69 139.54 8.16 1.0
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Table 5.8: Statistics of the effect of traffic shading on annual DC yield for left and right lane of A12

A12 Teoverage EY AEY Reduction
DC yield [hy] [KWh/m?2/y] | [KWh/m?/y] [%]
Average 240.76 137.98 4.18 29
Maximum | 448.91 156.59 8.13 6.8
Minimum 123.09 1.64 0.00 0.0

StD 47.69 21.96 1.27 1.0

§ A12
Traffic shading time [h/y]
e 0-50
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151 - 250
251 -350
351 - 450

Figure 5.12: Knooppunt Lunetten in the South-East of Utrecht (1:25.000). The points along the road indicates the traffic coverage
factor in the specific location

5.5.2. Example 2 - Van Brienenoordbrug (A16)

The road section of A16 in which the traffic shading time has been observed to be higher
than 350 h/y is 500 m after the bridge Van Brienenoordbrug, at the exit 25 (Capelle a/d
Ijssell) before an interchange. In general, traffic shading factor above 350 h/y and irradiation
reduction up to 57.34 kWh/m?/y (around 6%) has been recorded in this area. The DC yield
reduction observed is up to 9 kWh/m?/y, meaning a percentage reduction of 6% of the total
generation.

Figure 5.13 represents the location in an image extracted from LiDAR data and the traffic
shading time for each analyzed point is shown using the same colour map as explained in
the legend. The vehicles flow directions are shown with red arrows and the point with the
highest traffic coverage time (416 h/y) is indicated.
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Figure 5.13: Brienenoordbrug in the East of Rotterdam (1:20.000). The points along the road indicates the traffic coverage factor
in the specific location



Conclusions

The goal of this research project was to develop a method to estimate the irradiation and
DC yield potential of solar roads in the Netherlands. The three main research objectives
addressed in 1.2 are here synthesized.

6.1. Development of a method to estimate the irradiation and DC
yield potential of solar highways in the Netherlands

The open-source map of the Hectopunten along the main Dutch roads was used to identify
the locations of the points along the road where the model is applied. The points have a
relative distance of 100 m in the length of the road and of 15 m in the width. A tool developed
by M. Kaijser, described in 3.3, was applied to extract the skyline profile of these points from
LiDAR data. To these points, the irradiation and DC yield model was applied.

In order to obtain the irradiation and DC yield potential of solar highways in the Nether-
lands, conventional approaches to obtain irradiation and DC yield values for a specific loca-
tion resulted to be not effective. Therefore, another approach was chosen, the irradiation and
DC yield coefficients method developed by A. Calcabrini, presented in 2.2.2 and 2.2.3. The ir-
radiation model was improved to better simulate solar road operational conditions. This was
achieved correcting the irradiance input, considering a reduction due to the optical air mass
of Earth’s atmosphere and due to the misalignment between the normal to the module and
the sun altitude (angle of incidence). These modifications resulted in a significant reduction
of sunlight reaching the solar road surface in the first 10° of altitude. With the introduction
of the optical air mass and angle of incidence correction factors, 98% of the model results
deviate only 5% from the values obtained with the reference model (Perez). Before, the model
could give this range of deviation for only 66% of the values.

A traffic shading model was also successfully developed. The model aims to estimate the
irradiation that is shaded by passing vehicles on a solar road. It is based on real traffic
data provided by the Faculty of Civil Engineering and Geoscience with the research project of
DiTTLAB. The data were provided for one point each 200 m, for both left and right lanes. The
data of vehicles flow and speed were converted into the amount of time in which a solar road
point is completely shaded by a vehicle at each hour of the day, called traffic coverage time.
The traffic coverage time was used to correct the SCF and SVF into traffic coverage factor
(TCF) and traffic view factor (TVF) in order to account for traffic shading in addition to the
skyline profile. The model was applied to the highways A12 and A16, chosen among the four
busiest roads in the Netherlands. Therefore, their traffic data deliver results of worst-case
traffic scenarios for the average highways of the country.

Eventually, to account for conductive thermal exchange between the building layers of the
solar road, the fluid dynamic model used to estimate conventional module temperature is also
modified. The temperature model developed by V. Kumaravel to estimate the temperature
variation with time of the TNO SolaRoad prototype, and described in Section 4.3, has been
implemented. The input data were changed to simulate the glueable solar road technology
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assumed in this research project, according to the technology assumptions mentioned in
Appendix E. The modification resulted in a decrease of around 2% of the maximum DC yield
potential due to module temperature deviation from STC. This deviation is lower than the one
observed for conventional modules, usually assumed to be around 6% [20]. Further research
into the material properties needs to be conducted to explain this difference in a satisfying
way. However, it can be said that the ground plays an important role as massive heat-sink.
In comparison with the TNO SolaRoad technology, deviations of 8, 6 and 3 kWh/m?/y for
mono c-Si, poly c-Si and CIGS were observed. This is probably due to the fact that the
assumed glueable technology is around 6 time thinner than the TNO SolaRoad and therefore
experiences less heat accumulation. However, further research and testing of the assumed
technology should be conducted in order to validate the simulation results.

6.2. Evaluation of the model sensitivity

The sensitivity of the model has been evaluated for the following two aspects:

1. the increase of the azimuth step angle when generating the skyline profile, which means
a reduction of the resolution of the obtained skyline profile;

2. the reduction of the analyzed point density, which means a decrease of the relative
distance between the analyzed points.

The model results to be more sensitive to the variation of the skyline resolution. Increasing
the step angle from 1° to 5°, 10° and 20°, increased the deviation from the reference values of
irradiation to 0.2%, 1.3%, 3.7% and 7.6%, respectively. However, the increase of the azimuth
step angle can significantly reduce the computational time to extract the skyline profile. The
optimal balance between accuracy and number of calculations has been found at 5° azimuth
step angle, where 80% reduction of the calculation time can be achieved with less than 2%
deviation from the reference values.

The relative distance between points has been increased from 1 (reference case) to 10, 20,
50, 100, 200 and 500 m. The deviation from the average irradiation obtained in the reference
case goes from 0.1% up to 2.2%. The deviation from the maximum irradiation obtained in
the reference case is instead higher and goes from 1.6% up to 4.8%. The optimal balance
between reduction of the number of points to be analyzed and results deviation was found at
100 m relative distance between the points with 0.4% deviation from reference average and
1.6% deviation from maximum reference.

6.3. Estimation of the irradiation and DC yield potential of solar
highways in the Netherlands

The results of the skyline profile extraction showed that solar roads have an average SVF of
0.9. Therefore, it can be stated that highways mainly show almost free horizon conditions. It
was observed that built-up areas reduce SVF, but that they are not the only relevant factor.
Bridges and especially trees aligned along the roadside are a common cause of significant
shade. However, it is difficult to express a general statement, since highways in urban areas
tend instead to be built far away from buildings - in order to reduce the noise - whereas
tree-lined avenues are more common in the countryside.

A map of the irradiation potential of solar highways for the whole Netherlands was gen-
erated and it was shown in Section 5.3. The road sections that receive higher annual irra-
diation are normally elevated road sections or roads that pass through the countryside. On
the other hand, low irradiation potentials are mainly caused by surrounding buildings in
densely built-up areas (urban areas), trees along the roadside, underpasses or distortion of
the LiDAR data, as explained in Section 3.2.2. Solar highways in the Netherlands receives
an average irradiation of 882 kWh/m?/y, 14% less than the maximum irradiation achievable
by a 0° tilt mounted module (1026 kWh/m? /y), and 35% less than the maximum irradiation
received by an optimally tilted module (1367 kWh/m?/y) in South Holland. The three most
irradiated highways are A31, A5 and A200 with average annual irradiation of 1002, 999 and
983 KWh/m?/y, respectively. All three mainly cross the countryside.
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To give a more detailed example, the ring road around Amsterdam was considered. The
A10 annual average irradiation was found to be 881 kWh/m?/y, with a maximum peak of
1022 kWh/?/y in the area of Watergraafsmeer, Ringweg Oost. With the use of the potential
map, it was possible to identify several optimal locations for a solar road installation on
the A10. As an example, the road section South-West to the Tweede Coentunnel receives
average irradiation of 940 KWh/m?/y and presents a larger surface to be covered with solar
road modules due to increase of the number of lanes. In addition, an example of a site that
does not seem suitable for solar road application was indicated as well. It is located in the
East part of the Ringweg Noord, where the A10 crosses the S115. The irradiation reduction
is caused both by the presence of a bridge passing over the highway and by trees aligned
along the roadside.

A map of the poly c-Si DC yield potential of solar highways for the whole Netherlands was
generated as well and can be found in Section 5.4. For poly c-Si modules, solar highways in
the Netherlands show an average output of 138 KWh/m?/y, with peaks of 160 KWh/m?/y. If
mono c-Si is installed, the average increases to 174 KWh/m?/y, while the use of CIGS would
reduce it to 90 KWh/m?/y (considering the assumed technologies, as described in Appendix
E. The top three roads A31, A5 and A200 were found to generate an average between 154
and 157 KWh/m?/y with poly c-Si, between 192 and 196 KWh/m?/y with mono c-Si, and
between 100 and 105 KWh/m?/y with CIGS.

In total, covering the entire Dutch highways network with solar road modules would gen-
erate 5.2 TWh/y, 6.6 TWh/y, and 3.4 TWh/y if poly c-Si, mono c-Si and CIGS technologies
are assumed, respectively. This equals 3-5 % of the national electricity consumption (120
TWh according to the CBS 2018). Assuming that 15% of the electricity consumption goes to
street lighting, solar highways solely could power up to 36% of the national demand. This
would significantly reduce the consumption of fossil fuels and the CO2 impact in the Dutch
energy sector.

6.3.1. Evaluation of traffic shading on irradiation and DC yield potential

Traffic shading has also been analyzed for the case of A12 and A16. It resulted that on aver-
age solar road modules are covered by vehicles almost 240 hours per year, with some points
reaching a peak of 450 hours. A map of this value was generated for the two case studies
of the A16 and A12 and can be found in Section 5.4 and in Appendix D. The reduction of
irradiation potential resulted to be on average of 27 kWh/m? /y, with peaks of 57 kWh/m?/y.
In percentages, irradiation reduction caused by traffic stays around 3% with isolated max-
imum values up to 6.8%. As a consequence, DC yield potential is reduced on average by 4
kWh/m?/y in the same locations, with peaks of almost 9 kWh/m?/y. Per cent reduction of
energy output remains below 3% of the annual yield, with some isolated cases where it rises
to 7%. According to the results, traffic did not show to drastically decrease the potential of
solar highways. Nevertheless, losses caused by traffic shading are comparable with inverter
conversion losses (around 5%) and need therefore to be taken into consideration.

In addition, it is interesting to observe which are the situations in which traffic generates
the highest losses. In fact, this information might be helpful to decide where to place the
solar road. For this purpose, the case of the interchange Knooppunt Lunetten on the A12
and the bridge Van Brienenoordbrug on the A16 were further analyzed. The aim was to give
an example of two characteristic road sections in which the shape and function of the road
normally increase the traffic and consequently the traffic shading. In general, interchanges
are used to deviate the routes of vehicles into different directions and they mainly connect
roads of different dimensions and types. At the entrance of an interchange (called ramp),
vehicles with lower driving speed are injected into the flow of a high-speed road (a highway for
example). This can be a cause of congestion because the flow of cars suddenly increases and
the average speed decreases on the point. This is the case at Knooppunt Lunetten, where the
line after a ramp shows a traffic coverage time of 402 h/y, with a reduction of the irradiation
potential up to 50 kWh/m?/y (around 5% of the annual irradiation) and consequently DC
yield reduction of 8 kWh/m?/y (almost 6% of the annual generation). Bridges also increase
traffic shading, due to the fact that they are the connecting point between two sides of a
river or of another crossing highway. To make the construction of a bridge effective, many
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roads are directed to few bridges. This increases the flow of cars and consequently the traffic
shading. In the analyzed case of Van Brienenoordbrug the traffic coverage time reaches 416
h/y, causing a reduction of the irradiation potential up to 57 kWh/m?/y (around 6% of the
annual irradiation). Consequently, the DC yield decreases by 8 kWh/m?/y (almost 6% of the
annual generation).



Recommendations

Referring to the scarce literature and data collection regarding the performance of solar roads,
it can be noticed that the energy output provided by test installations are significantly lower
than the results obtained with the model presented here. This is due to the fact that the model
is still very optimistic in estimating the performance of the modules. The numbers given
represent the optimal potential of each location analyzed. However, future development of the
model will need to take into account many other relevant aspects. The most important, based
on the experience of TNO and Wattway by Colas, seemed to be the delamination of the ASL.
Further improvement of the technology will decrease this effect, but an efficiency drop due
to surface wear should be accounted for in the model. Studies should be conducted in order
to evaluate its actual impact on the performance of the PV modules. Another very important
aspect is considered to be soiling and accumulation of dirtiness on the road surface. This
also has not been implemented in the model yet and represent therefore another source of
discrepancy with real data. In addition, the materials and building elements of solar roads
should be further studied to implement a more accurate temperature model.

7.1. Suggestions for the model improvement

For the improvement of the research project here presented, the following recommendations
are made.

* In the model presented in this report, solar roads are assumed to have 0° tilt angle.
However, this is not exactly the case for roads in reality. For reasons such as drainage
purposes but also driving comfort in turns, roads are built with varying inclinations.
A study of the average inclination along a road section and the implementation of the
obtained value as the tilt angle for the solar road modules could further improve the
model output.

* The Aol correction factor presented in this report was for the improvement of 0° tilted
modules. To extend the correction to other tilt angles different orientations need to be
considered as well.

* In order to obtain single road points, they need to be selected from the whole Hectop-
unten map. This is a very time-consuming process that would need to be addressed
differently in order to reduce the time of extraction of a solar road potential. In addi-
tion, the superposition of the Hectopunten map and the LiDAR data does not account
for the difference of height between for example two roads that cross each other. The
same point that represents the road that passes below will be projected at the top of
the road passing above. This will result in a wrong estimation of the potential. In the
case of this project, these points were manually removed. However, this process was
very time-consuming. The model could be improved by accounting for the difference of
height between two following points. The algorithm should detect that two consecutive
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points have a height different that overcome a fixed threshold. In this case, the height of
the wrong displaced point could be corrected. Figures 7.1a and 7.1b give two examples
of cases in which the data needed to be manually removed.

L

(a) The injecting road and the main road below are at dif- (b) Points representing a going in an underpassage below

ferent level (heights). The red points should not be con- a canal. The points marked in light blue are already in a

sidered together with the points marked in light blue. tunnel and, together with the points represented above
water, should not be considered.

Figure 7.1: Examples of manual corrections of the Hectopunten map

* LiDAR data do not show the real shape of objects, but only the one that can actually be
detected from above. For modules placed on the ground, this can represent a large error
in representing the light that can reach the solar road surface. Figure 7.2 shows that
part of the sun path passes below the tree planted along the SolaRoad in Krommenie.
However, the skyline extraction methods applied until now in PV system modelling do
not account for this area of the sky, as represented by the red skyline profile in the figure.
It may be possible to evaluate the impact of this underestimation on the irradiation
potential.

* Interpolation is a critical point for solar irradiation. On a regional scale, many stud-
ies can be found regarding the evaluation of different interpolation methods. However,
when the scale is reduced, like in the case of the research study here presented, the re-
sults are too location-dependent to be interpolated with the same methodologies. There-
fore, a deeper study of the most suitable interpolation methods for solar road irradiation
and DC yield potential should be conducted.

* The traffic shading model provides an estimated DC yield loss due to vehicles shad-
ing that does not consider the cells interconnection nor the geometry of the modules.
Frequency of hot spots formation in the modules due to traffic jam, together with the
consequences in terms of output losses, should be further analyzed.

* The traffic shading model accounts only for the direct shade of a vehicle passing on
the cell. It does not account for the shadow that vehicles project on the road surface
due to their height. This shadow changes shape and area every moment of the day,
depending on the altitude of the sun. This extension of vehicles’ shadow on road surface
could be introduced in future versions of the model. Additionally, different vehicles
dimensions could also be considered. This could be modelled using the direct LiDAR
points distributed along the road surface, which could give a resolution of data of around
1 m2. However, this requires a very large computational power and it is extremely time-
consuming. Therefore, this approach is suggested for only small selected areas.

* It is interesting to know if the traffic coverage time could be more quickly correlated
to an irradiation reduction on the road surface. Figure 7.3 shows the scatter graphs
of the correlation between traffic coverage time and per cent irradiation reduction in
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Figure 7.2: Skyline profile of Point 3 (RD coordinates: 112.841, 500.877) along the TNO SolaRoad. The extraction of the skyline
profile was obtained with an Horicatcher picture and the software Meteonorm.

the respective points for the A12 and A16. Correlation coefficients of 0.86 and 0.78
are obtained, respectively. This means that the data are strongly correlated and that a
linear function can represent the increase of percentage irradiation reduction with the
increase of traffic coverage time.

The collection of more data from other roads could bring to a more accurate and solid
understanding of this correlation. It would then be possible to provide a quick method
to estimate how the traffic can impact on the percentage reduction of irradiation in a
location. In fact, only providing flow and speed data is possible to estimate the annual
traffic coverage time of a point. Given the slope of the linear regression that correlates
the traffic coverage time with the irradiation reduction, the impact of traffic on the solar
road potential could be easily estimated.
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Figure 7.3: Scatter graphs that represent the correlation between the traffic coverage time and the per cent irradiation reduction
for A12 (left) and A16 (right).

* Eventually, the suitability of the applied temperature model to represent thermal ex-
change in the thin glueable technology needs to be critically investigated. From the
results, the module temperature does not seem to be sufficiently responsive to ground
and ambient temperature when compared with the TNO SolaRoad model. Further re-
search into the materials and building methods should be conducted in order to improve
the model inputs.
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7.2. Further development of the model with soiling effect

The third major environmental factor that affects power losses in photovoltaic modules is
the so-called soiling effect [55]. It is referred to soiling losses when the transmitted light of a
module is reduced due to shading or refraction caused by snow, dirt, dust, sand, biological
deposit, bird droppings and more, deposited on the array surface. These losses can reduce
the system annual yield up to 20 % [44] and increase therefore its LCOE.

In case of solar roads, the soiling effect is expected to have a significant impact on the
effective power conversion for three main reasons: (1) the proximity to an intense source
of particulate matter (PM) such as cars and other vehicles, (2) the horizontal position that
decrease the action of natural cleaning agents like rain, and (3) the roughness of the surface,
which increases the capture and adhesion of dirtiness.

In built-up environments, the sources of dust are several: combustion processes, which
include emission of pollutants and ash, industrial processes vehicular movements and agri-
cultural activities majorly contribute to suspended particles in the atmosphere [55]. The
contribution of some of them is given in Table 7.1.

Table 7.1: Contribution of different sources to outdoor PM concentration [11]

Source Range of outdoor air [ g/m?]
Cooking 2-3
Wood burning 1-4
Soil dust 1-23
Industry, heating 4-6
Traffic emission (mostly diesel) 5-17
Secondary PM (SO3~, NO3, NH}) 11-22

These particles are transported by the wind and adhere to the module surface. While
transportation mainly depends on the environmental conditions, the adhesion process in-
volves also the module tilt and orientation and its surface characteristics [55].

Module tilt: In case of solar roads, where modules are assumed to have a tilt of 0°, the
deposition mechanism of gravitational settling is dominant and result in a high rate of dust
deposition [29]. However, the gravitational settling velocity is directly proportional to the
squared diameter of the particle. We can, therefore, conclude that for solar roads the de-
position rate will be particularly high for larger particles, whereas small particle will tend to
adhere to surfaces with higher tilt through the mechanism of dust diffusion [29].

PV technology: The soiling of the module surfaces influence its spectral transmission. Power
losses depend, therefore, on the bandgap of the applied PV technology. The experiments
conducted in [54] show that for a fixed dust coverage, the soiling losses were 7% higher for
a-Si in respect with conventional c-Si modules. Amorphous silicon absorbs light with larger
wavelengths, while crystalline silicon cells work for shorter wavelengths. We can, therefore,
conclude, that for larger wavelength soiling losses due to spectrum modifications are higher
with respect to shorter wavelengths.

Module surface: Module textured surfaces aim to increase the absorbed light, reducing re-
flection losses. However, dust particles and other sources of soiling are more easily trapped
by these surfaces, increasing the soiling ratio of the module. Additionally, the cleaning pro-
cesses, both artificial and manual, are made less efficient in removing the dust particles from
the trap sites. This aspect is important to be considered in the case of solar roads because
their surfaces are made rougher than a conventional PV module to recreate the anti-skid
conditions of asphalt.

Wind speed: In [29], it is stated that the dust accumulation is a result of the difference
between the rate of deposition and rate of removal by the wind. At very low tilt angle, as in
the case of solar roads, the limitation of the air boundary layer decreases the removal of dust
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carried by the wind. However, the dust removal rate is directly proportional to the diameter
of the particles. As stated before, solar roads will more likely be affected by large size dust
particles, which however will more easily be removed by the wind as well.

Rainfall: At low tilt, light rainfall (<20 mm) can cause the formation of dust spots and facil-
itate the cementation of dust particles on the module surface. In an experiment conducted
in California by Kimber et al. in 2006, it has been observed that a minimum of 20 mm of
rainfall is required to effectively clean optimally tilted PV modules [15].

Relative humidity and dew frequency: Humid conditions and dew formation increases
dust adhesion as wet surfaces attract more dust particles [29].

In [44], two types of soil shading are recognized: soft shading and hard shading. Soft
shading refers to the uniform accumulation of light dust or fine pollution on the surface. This
causes an overall reduction of the short circuit current. Hard shading takes place instead
when a solid such as local accumulated dust shades the module, creating the condition
of partial shading. In this situation, if bypass diodes are applied to maintain the current
constant, a drop of voltage occurs.

All this considered, in order to account for soling losses in the solar road model here pre-
sented, further studies regarding soiling accumulation in order to define the angular soiling
coefficient a, for solar roads need to be conducted. Based on the literature review and the
personal observation of the pilot project of TNO SolaRoad in Krommenie, operating since
2014, it is firmly believed that soiling losses account for a high reduction of solar roads gen-
eration potential. Therefore, it is therefore highly recommended to focus on modelling the
soiling losses for further research on the topic of solar road potential estimation.

In addition to that, pollution and haze should also be taken into consideration. The in-
troduction in the model of spectral dependence irradiance would then be needed.

7.3. Solar road feasibility studies

Now that the potential of solar roads can be simulated in an effective, quick and accurate
way, it is important to address a different aspect of the technology in order to assess the
feasibility of a solar road installation. In fact, as already mentioned in Section 4.1, not only
the irradiation and DC yield potential are determinant when evaluating solar road projects,
but also the following aspects should be further studied and considered:

* Dynamic shading: the effect of dynamic shading on the efficiency of the maximum
power point tracker should be further researched. In [73], Y. Haoyuan et al. developed
a MATLAB-based model that accounts for the dynamic characteristics of a photovoltaic
(PV) module under a dynamic shadow with different degrees of shading. They observed
that shadows with different trajectories (such as initial point, speed and path) could
differently change the power-voltage curve of the investigated module.

* Noise generation: if solar road modules substitute the porous asphalt of conventional
road surfaces, a higher vehicle noise generation should be accounted for. This can
restrict the number of sites available for solar roads installation, especially in urban
areas;

* Grid connection: the possibility to connect solar roads to the grid should be verified
for each location. Additionally, the placement of inverters along the solar road instal-
lation should be taken into account, together with all the consequences of costs, social
acceptance, space availability, etc.;

* Road surface deterioration: from the solar roads pilot projects that are running around
the world, it has been observed that the ASL tends to delaminate with time and usage.
This causes a decrease of conversion efficiency that needs to be taken into account when
modelling solar roads output. Further studies and data collection are still needed. The
evaluation of the impact on road safety needs to be researched as well;
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7. Recommendations

* Costs: solar road applications are still significantly more expensive than conventional
modules. An accurate assessment of investment capital, maintenance costs and pay-
back time needs to be addressed in order to correctly evaluate solar road projects. In
addition, a study of the energy payback time of the technology should be conducted: if
a solar road requires more energy to be produced than the one that it generates during
its lifetime, is it still reasonable to build a solar road system?
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Actuele Hoogtebestand Nederland
(AHN3)

Figure A.1 depicts in which year each region of the Netherlands was provided with full LiDAR
data AHN3. As it can be observed, at the time in which this research project has been
conducted (2019), the Nord-East region of Groeningen did not have available LiDAR data yet
and it was therefore impossible to complete the solar road map for that area.

Noord zee

Figure A.1: Years in which LiDAR measurements have been conducted for each region of the Netherlands (source: Esri Neder-
land, Community Map Contributors)
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B.1. Azimuth step angle

Sensitivity analysis

Table B.1: Results of the sensitivity analysis for azimuth step angle increase

Step angle [°] 1 2 5 10 20

Calculations [-] | 32400 | 16200 | 6480 | 3240 | 1620
Mean deviation 0 02% | 1.29% | 3.7% | 7.6%
Std 0 21% | 4.0% | 4.5% | 8.1%

B.2. Points density

Table B.2: Results of the sensitivity analysis for points density on road length

Relative distance | N,,;;s | Mean(lrr) | Max(lrr) | Min(lrr) | Dev from mean | Dev from max
[m] [-] [kW/m?] | [kW/m?] | [kKW/m?] [%] [%]
1 14666 782 1003 0 - -
10 1466 783 987 5 -0.13 1.6
20 733 784 987 13 -0.26 1.6
50 293 784 987 5 -0.26 1.6
100 147 785 987 13 -0.38 1.6
200 73 793 954 13 -1.41 4.89
500 28 769 955 13 1.66 4.79
1000 14 799 955 13 -2.17 4.79

Table B.3: Results of the sensitivity analysis for points density on road width

Relative distance | N,,;;s | Mean(lrr) | Max(lrr) | Min(lrr) | Dev from mean | Dev from max
[m] [-] [kW/m?] | [kW/m?] | [kKW/m?] [%] [%]
5 15 742 925 406 - -
15 4 782 878 649 -5.39 5.08
20 2 764 878 649 -2.96 5.08
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B. Sensitivity analysis

B.3. AM correction factor

Table B.4: Improvement of the coefficient of determination in the model, after applying the AM correction factor

R? - Antofagasta [°] 0 20 45 70 90
Original model 0.9821 0.9764 0978 0.9871 0.992
AM correction 0.9920 0.9809 0.9773 0.9855 0.9895
R? - Delft [°] 0 20 45 70 90
Original model 0.9712 0975 0.982 0.9872 0.9882
AM correction 0.9887 0.9846 0.986 0.9889 0.9889
R? - Reykjavik [°] 0 20 45 70 90
Original model 0.9704 0.9774 0.9817 0.9845 0.9853
AM correction 0.9935 0.9873 0.9875 0.9885 0.9877
R? - Bata [°] 0 20 45 70 90
Original model 0.9839 0.9836 0.983 0.9904 0.9928
AM correction 0.9938 0.989 0.9833 0.9902 0.9922




Irradiation and DC yield maps

C.1. Irradiation potential of solar highways in the Netherlands

1026 1] 160
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Figure C.1: Jenks Natural Breaks classification for (a) irradiation and (b) DC yield potential expressed in kWh/m?2/y.
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90 C. Irradiation and DC yield maps

Table C.1: Statistics of SVF along highways in the Netherlands

Road | Number of points | Avg SVF | Max SVF | Min SVF | StD

A1 2678 0.90 0.99 0.00 0.12
A10 891 0.88 0.99 0.06 0.13
A12 3255 0.89 0.99 0.00 0.12
A13 357 0.89 0.99 0.09 0.11
A15 3608 0.91 0.99 0.01 0.13
A16 2960 0.88 0.99 0.02 0.16
A17 655 0.91 0.99 0.02 0.14
A18 449 0.91 0.99 0.25 0.10

A2 6153 0.89 0.99 0.00 0.14
A20 891 0.86 0.99 0.07 0.14
A200 94 0.95 0.99 0.71 0.04
A22 144 0.81 0.99 0.05 0.17
A27 2388 0.90 0.99 0.02 0.12
A28 3503 0.90 0.99 0.01 0.12
A29 661 0.91 0.99 0.02 0.14
A30 349 0.92 0.99 0.01 0.09
A31 384 0.98 0.99 0.04 0.06
A32 1340 0.96 0.99 0.27 0.06
A38 34 0.88 0.99 0.67 0.08

A4 2808 0.92 0.99 0.07 0.12
Ad4 414 0.89 0.99 0.18 0.1

A5 378 0.97 0.99 0.28 0.06
A50 3026 0.90 0.99 0.00 0.14
A58 2876 0.91 0.99 0.00 0.14
A59 2089 0.92 0.99 0.00 0.11

A6 2166 0.94 0.99 0.09 0.09
AB5 397 0.78 0.99 0.00 0.18
AB7 1519 0.87 0.99 0.00 0.16

A7 3439 0.94 0.99 0.02 0.10
A73 2681 0.93 0.99 0.00 0.11
A74 28 0.92 0.99 0.62 0.08
A76 592 0.89 0.99 0.20 0.12
AT7 202 0.93 0.99 0.01 0.10
A79 350 0.86 0.99 0.24 0.12

A8 200 0.91 0.99 0.06 0.12

A9 1058 0.92 0.99 0.04 0.11
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Table C.2: Statistics of irradiation potential of solar highways in the Netherlands

Road | Number | Average Irr Max Irr Min Irr StD
of points | [kWh/y/m?] | [kWh/y/m?] | [KWh/y/m?] | [kWh/y/m?]
A1 2678 896.67 1023.39 0.34 137.32
A10 891 881.29 1022.52 27.17 161.91
A12 3255 794.54 1004.42 2 151
A13 357 773 979.03 38.39 140.51
A15 3608 835.67 1015.26 3.83 160.65
A16 2960 804.84 1014.77 6.3 183.78
A17 655 830.53 1000.18 713 164.96
A18 449 885.7 980.5 191.97 114.79
A2 6153 809.87 1009.89 0.57 162.51
A20 891 763.16 997.59 38.22 172.74
A200 94 982.68 1020.71 549.56 57.31
A22 144 820.04 1015.83 22.06 191.07
A27 2388 916.72 1025.73 7.34 146.74
A28 3503 774.14 970.06 3.39 148.87
A29 661 834.65 1016.48 8.25 176.3
A30 349 898.09 980.97 4.61 101.31
A31 384 1002.19 1025.62 14.45 71.72
A32 1340 941.19 981.26 115.55 74.9
A38 34 875.45 1012.13 523.72 114.74
A4 2808 856.26 1020.27 29.99 156.79
Ad4 414 916.64 1023.2 260.73 122
A5 378 999.05 1023.81 116.91 64.77
A50 3026 899.91 1025.58 1.25 162.92
A58 2876 938.38 1025.57 0.99 153.61
A59 2089 932.07 1025.73 1.33 135.07
A6 2166 932.29 1025.76 38.82 103.49
AB5 397 775.61 1021.93 1.74 215.21
AG7 1519 889.72 1025.6 0.43 185.84
A7 3439 850.2 978.94 8.08 135.5
A73 2681 946.61 1025.9 0.66 125
A74 28 953.17 1021.58 782.53 53.62
A76 592 904.1 1024.18 109.18 142.99
ATT7 202 957.04 1024.24 2.59 118.99
A79 350 887.88 1024.62 118.84 142.87
A8 200 933.27 1022.21 43.94 137.13
A9 1058 938.1 1025.29 19.53 132.49
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C. Irradiation and DC yield maps

C.2. DC yield potential of solar highways in the Netherlands

Table C.3: TNO SolaRoad DC yield coefficients for South-West Netherlands

PV Technology d; d, d; d, ds Sum
0° Tilt [kW/m?] | [kW/m?] | [kW/m?] | [kW/m?] | [kW/m?] | [KW/m?]
mono c-Si 105 24 -13 77 0 193
poly c-Si 83 21 -11 61 0 154
CIGS 55 15 -8 40 0 102
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Table C.4: Statistics of DC yield potential of solar highways in the Netherlands with mono c-Si
Road | Avg DC yield | Max DC yield | Min DC yield StD Road length | Tot DC yield
[kWh/m?/y] [kWh/m?/y] [kWh/m?2ly] | [KWh/m?2ly] [km] [MWhly]
A1 176.7 200.5 0.1 27.0 157.0 416,222.7
A10 172.6 200.3 5.2 31.9 32.0 82,857.6
A12 155.4 196.8 0.4 29.8 137.0 319,244.3
A13 151.1 191.8 7.4 27.7 17.0 38,522.9
A15 163.5 198.9 0.7 31.6 204.0 500,248.8
A16 155.1 197.6 1.2 35.7 58.0 134,928.3
A17 162.5 195.9 14 325 39.0 95,039.1
A18 175.1 193.7 37.8 22.7 20.0 52,530.0
A2 158.4 197.8 0.1 32.0 212.0 503,648.4
A20 149.2 195.4 7.4 34.0 39.0 87,264.5
A200 192.6 200.0 107.0 1.4 1.0 2,888.3
A22 160.6 199.0 4.2 37.5 8.0 19,276.8
A27 179.6 201.0 14 28.9 109.0 293,613.3
A28 153.0 191.7 0.7 29.5 187.0 429,052.8
A29 163.3 199.1 1.6 34.7 13.0 31,839.6
A30 177.5 193.8 0.9 20.0 18.0 47,935.8
A31 196.4 200.9 2.8 141 65.0 191,451.0
A32 186.0 193.9 22.5 14.8 41.0 114,390.0
A38 171.5 198.3 102.0 22.6 1.5 3,858.1
A4 187.9 199.9 5.8 30.8 125.0 352,331.3
Ad4 179.6 200.5 51.0 24.0 28.0 75,432.0
A5 195.7 200.6 22.5 12.7 14.0 41,105.4
A50 176.9 200.9 0.2 31.9 100.0 265,410.0
A58 183.9 200.9 0.2 30.2 140.0 386,085.0
A59 182.6 201.0 0.3 26.6 75.0 205,413.8
A6 183.7 201.0 7.5 20.2 102.0 281,076.3
AB5 151.9 200.2 0.3 42.3 22.0 50,120.4
A67 174.3 200.9 0.1 36.5 78.0 203,919.3
A7 168.0 193.4 1.6 26.8 240.0 604,836.0
A73 185.5 201.0 0.1 24.6 114.0 317,119.5
A74 186.8 2001 153.3 10.5 20 5,603.7
A76 1771 200.7 211 28.1 27.0 71,733.6
ATT 187.5 200.7 0.5 23.4 10.0 28,126.5
A79 174.0 200.7 22.9 281 18.0 46,969.2
A8 182.8 200.3 8.5 27.0 10.0 27,426.0
A9 183.8 200.9 3.8 26.0 96.0 264,643.2
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Table C.5: Statistics of DC yield potential of solar highways in the Netherlands with poly c-Si

Road | Avg DC yield | Max DC yield | Min DC yield StD Road length | Tot DC yield
[kWh/m?/y] [kWh/m?/y] [kWh/m?ly] | [KWh/m?/y] [km] [MWhly]
A1 140.1 160.6 0.1 21.5 157.0 329,982.6
A10 138.3 160.5 4.2 255 32.0 66,403.2
A12 124.5 157.6 0.3 23.8 137.0 255,929.7
A13 1211 153.6 5.9 22.2 17.0 30,885.6
A15 131.0 159.3 0.6 25.3 204.0 400,951.8
A16 124.3 158.3 1.0 28.6 58.0 108,158.4
A17 130.2 157.0 1.1 26.0 39.0 76,172.9
A18 138.1 152.8 29.7 17.9 20.0 41,430.0
A2 127.0 158.5 0.1 25.6 212.0 403,732.8
A20 119.6 156.5 5.9 27.3 39.0 69,960.2
A200 154.3 160.2 85.9 9.0 1.0 2,313.9
A22 128.8 159.4 3.4 30.0 8.0 15,452.4
A27 143.9 161.0 1.1 23.1 109.0 235292.9
A28 120.6 151.2 0.5 23.3 187.0 338,198.9
A29 130.9 159.5 1.3 27.8 13.0 25,519.7
A30 140.0 152.8 0.7 145.8 18.0 37,808.1
A31 157.3 160.9 2.2 11.3 65.0 153,367.5
A32 146.7 152.9 17.7 1.7 41.0 90,220.5
A38 137.4 158.9 81.8 18.1 1.5 3,092.2
A4 134.6 160.1 4.6 247 125.0 252,318.8
Ad4 143.9 160.6 41.1 19.2 28.0 60,446.4
A5 156.8 160.7 17.9 10.2 14.0 32,928.0
A50 140.9 160.9 0.2 25.6 100.0 211,335.0
A58 147.3 160.9 0.2 241 140.0 309,351.0
A59 146.3 161.0 0.2 21.3 75.0 164,598.8
A6 145.7 161.0 6.0 16.3 102.0 222,905.7
AB5 121.8 160.4 0.3 33.9 22.0 40,180.8
AB7 139.7 160.9 0.1 29.2 78.0 163,413.9
A7 132.5 152.5 1.2 21.2 240.0 476,892.0
A73 148.6 161.0 0.1 19.6 114.0 254,088.9
A74 149.7 160.3 122.9 8.3 20 4,490.1
A76 141.9 160.7 16.9 22.5 27.0 57,485.7
ATT 150.2 160.7 0.4 18.7 10.0 22,534.5
A79 139.4 160.8 18.3 225 18.0 37,643.4
A8 146.5 160.4 6.8 21.6 10.0 21,976.5
A9 147.3 160.9 3.0 20.8 96.0 212,054.4
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Table C.6: Statistics of DC yield potential of solar highways in the Netherlands with CIGS
Road | Avg DC yield | Max DC yield | Min DC yield StD Road length | Tot DC yield
[kWh/m?/y] [kWh/m?/y] [kWh/m?2ly] | [KWh/m?2ly] [km] [MWhly]
A1 91.5 104.7 0.0 14.1 157.0 215,529.6
A10 90.2 104.7 2.7 16.6 32.0 43,310.4
A12 81.2 102.8 0.2 15.5 137.0 166,907 .1
A13 79.0 100.2 3.8 14.5 17.0 20,142.5
A15 85.5 103.9 0.4 16.5 204.0 261,507.6
A16 81.1 103.3 0.6 18.6 58.0 70,539.6
A17 84.9 102.4 0.7 17.0 39.0 49,678.2
A18 90.3 99.9 19.4 1.7 20.0 27,078.0
A2 82.8 103.4 0.1 16.7 212.0 263,304.0
A20 78.0 1021 3.9 17.8 39.0 45,624.2
A200 100.6 104.5 56.0 5.9 1.0 1,509.2
A22 84.0 104.0 2.2 19.6 8.0 10,080.0
A27 93.9 105.0 0.7 15.1 109.0 153,477.5
A28 78.9 98.8 0.3 15.2 187.0 221,258.4
A29 85.4 104.0 0.8 18.1 13.0 16,643.3
A30 91.5 99.9 0.5 10.3 18.0 24,710.4
A31 102.6 105.0 14 7.3 65.0 100,025.3
A32 95.9 99.9 1.7 7.6 41.0 58,966.2
A38 89.6 103.6 53.4 11.8 1.5 2,016.9
A4 87.8 104.4 3.0 16.1 125.0 164,568.8
Ad4 93.9 104.7 26.8 12.5 28.0 39,4254
A5 102.3 104.8 1.7 6.6 14.0 21,474.6
A50 92.0 105.0 0.1 16.7 100.0 137,955.0
A58 86.1 105.0 0.1 15.8 140.0 180,768.0
A59 95.4 105.0 0.1 13.9 75.0 107,347.5
A6 95.2 105.0 3.9 10.6 102.0 145,579.5
AB5 79.4 104.6 0.2 221 22.0 26,208.6
A67 911 105.0 0.0 19.1 78.0 106,587.0
A7 86.6 99.7 0.8 13.8 240.0 311,868.0
A73 96.9 105.0 0.1 12.8 114.0 165,733.2
A74 97.6 104.6 80.2 5.5 20 2,928.6
A76 92.6 104.8 11.0 14.7 27.0 37,494.9
ATT 98.0 104.8 0.3 12.2 10.0 14,698.5
A79 90.9 104.9 11.9 14.7 18.0 24,5511
A8 95.6 104.6 4.5 141 10.0 14,332.5
A9 96.0 104.9 20 13.5 96.0 138,297.6







Traffic shading model output
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Figure D.1: Traffic coverage time map of A12 - Section A
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Legend

Interpolated A12

Traffic shading time [hly]

weer High : 450
r N

-Low:58 A

Figure D.2: Traffic coverage time map of A12 - Section A-B
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Figure D.3: Traffic coverage time map of A12 - Section B-C
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Figure D.4: Traffic coverage time map of A12 - Section C-D
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Figure D.5: Irradiation potential map for A12 and A16 after the introduction of traffic shading
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Temperature model

Table E.1 reports the assumptions made for the three PV technologies applied in the model.
The modules are the ones assumed in the simulation conducted by A. Shekhar and V. Ku-
maravel in [19]. Table E.2 summarizes the assumptions made for the glueable technology
analyzed in this research. The choice of the materials and the thickness is inspired by the so-
lar road concept of Wattway by Colas and is based on literature review and personal commu-
nications. The glueable solar road technology assumed in the temperature model is depicted
in Figure 2.4 and it is composed by the following elements:

* On the top a 2 mm ASL of silicone is placed, which is made rough by incorporated
sand particles in order to recreate the skid resistance of an asphalt road. The thermal
properties of the anti ASL are the ones specified in the work of V. Kumaravel [68].

* A 1.8 mm thick foil of PVC is assumed to encapsulate the PV cells and build the core of
the solar road module. The thermal behavior is simulated using the thermal properties
of PVC specified in the work of Y. Cengel and A. Ghajar [72].

* On the back of the modules, a 3 mm thick PVF foil is assumed, using the thermal
properties of DuPont™Tedlar® (PVF) films [27].

* Eventually, a 0.3 m thick layer of asphalt is assumed, referring to the material properties
given in [72].

Table E.1: Assumptions for the three PV technology simulated, where kr is the temperature correction factor for efficiency [20].

Mono c-Si | Poly ¢-Si | CIGS
Nefs 20% 16% 10.5%
Kr -0.0035/% | -0.003/% | -0.0025/%
Acery [m?] | 0.015 0.015 0.014
Neelr 67 67 72
Vocceu [V] | 0.68 0.67 0.68
Voc [VIm?] | 45.3 447 45.3
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E. Temperature model

Table E.2: Assumptions taken in the temperature model for solar road

Absorptivity Thermal Conductivity d Specific heatc, Reference

[%] [W/mK] [mm] [J/kgK] material

ASL 0.1 0.45 2 710 Silicone
Encapsulant 0.1 0.15 1.8 842 Tedlar/PVC
Backsheet 0.1 0.15 3 1063 Tedlar/PVF

Asphalt - 0.65 300 920 Asphalt




Manual

Materials on hand before starting:

10.

11.

List of the roads to be processed.

A folder for each road where you will save all the tiff/shape image and the excel files
related to that road only.

Go to pdok.nl and download the ‘Hectopunten’ and ‘maximum Snelheiden’ maps.
MATLAB installed with the IEModel.mat file and correlated functions
ArcMap 10.5.1 installed (or other versions). Please, make sure that you have the license

for Spatial Analyst’ and 3D Analyst’

Procedure 1 - Road cut

. Pick up a road from the excel list of roads and colour its cells in yellow/orange. In this

way, you know that someone is working on it.

. Findtheroadon https://www.rijkswaterstaat.nl/wegen/wegenoverzicht/index.

aspx. You need to know the exact begin and end of the road and be able to visually find
them again on LiDAR.

. Go to Pdok.nl > AHN3 > Downloads.

. Find in the map the subunits that include the road you want to analyse.

For each subunit: click on it > download (choose the desired resolution. Best one:
0.5-meter raster DSM).

. You will be asked to save the image. Choose “save as” and name the subunits with a

number starting from 1 (then 2,3,4, etc).

. Extract the zipped files and name them as well with numbers starting from 1. It is itself

not relevant to maintain any spatial order of the tiff images when you enumerate them.

. Open ArcMap 10.5.1. If you are using other versions, the names of the commands and

their path given in this manual might change.

. Add the LiDAR images from the road folder.

Click on the globe icon (full extent) and then zoom to the area represented by the LiDAR
maps.

Activate the Hectopunten map and recognize the road that you want to cut.
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106 F. Manual

12. Click on select features > select by polygon.

13. Select in a big area the entire road. This will help you to work with less data than the
entire map of Hectopunten.

14. Right-click to Hectpunten and choose Selection > Create layer from selected features.
15. You obtain a layer with ONLY the selected points called ‘Hectopunten selection’.
16. Now deselect the Hectpunten layer and leave the ‘Hectopunten selection’ selected.
17. Exclude the following points in your selection:
(@) In an injection of another road to the highways you are analysing, exclude the

points that are still on the other road (Figure F.la gives an example).

(b) When there is an underpass underwater, exclude the points that are positioned on
the water (Figure F.1b gives an example).

(c) When there is a crossing point you need to exclude the points of the road above (if
your road is going below another one) or the points of the road below (if your road
is going above the other one).

(d) In general, try to include only the points that are on the same road level.

(a) (b)

Figure F.1: (a) case of an injection in which the two roads are on different level, (b) case of a water underpassage.

18. For each time you conclude a selection:

(a) Right click on ‘Hectopunten selection’ > Selection > Create layers from selected
features. You will have a layer called ‘Hectopunten selection selection X’ (X = a
number)

(b) Clear the selection and move forward to the next section.
19. In this way complete the whole road.

20. Now you have a lot of ‘Hectopunten selection selection X’. You need to merge them
together in one single layer. Click on ArcToolbox > Data Management > General > Merge
(double click):

(a) In Input Datasets drag all the ‘Hectopunten selection selection’ (NOT the ‘Hectop-
unten selection’ and NOT the Hectopunten).

(b) Check if all the numbers are there (remember that the 1 is not there, is simply
called ‘Hectopunten selection selection’).

(c) In Output Dataset, change the name of the file with the name of the road.
(d) Press OK and wait until the whole road automatically appears in the map.

21. Now you have a layer with the name of the road. Go quickly through the road again to
see if you want to change something, for example, delete a point. In this case:
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22.

23.
24.

25.

26.

Go to Customize > Toolbars > Editor.
In the Editor Toolbar click on Editor > Start Editing.
Choose the layer of the merged road and press OK then Continue.

(a
(b
(c
(d
(e) Press the Delete button on your keyboard.

(f) In the Editor Toolbar click on Editor > Stop editing.
(g) Save the changes.

—_—— —=

Click on the black arrow and then click on the point that you want to delete.

Now you need to save the road layer. You do it by exporting the layer as a shapefile in
your server/external memory. Right-click on the road layer and press Data > Export
Data > Give a name and a folder to the exported data (it will be in the format of shapefile).

Answer YES to the message that asks you to save the layer.

Now you have two roads layers with the same name. The one in the folder called De-
fault.gdb is NOT saved in your server and you can delete it. All the layers called “selec-
tions” can also be deleted because now you merged them in one layer alone.

Well done! You are finished with this road. Now put the LiDAR data and the ArcGIS
layer of the road in the same folder with the name of the road.

Go to the excel file with the list of the roads and colour the cells of the respective road
in green so you will know that this road is done.

F.2. Procedure 2 - Generation of road buffer

In order to give the shape of the road to the interpolated values, a buffer that represents the
road surface is needed.

1.

o k> 0 bd

10.
11.

12.
13.

Open ArcMap.

Add Data>’maximum Snelheiden’ (if the layer is not already added in your ToC).
Choose Selection>Select by location.

In the list of the objects to be selected, choose 'maximum Snelheiden’.

As selecting objects, choose the road points of the road for which you want to create the
buffer.

Define a search distance (suggested: not higher than 10 m). In this way, the software
will select the lines of 'maximum Snelheiden’ that are in a range of max the search
distance from the roads points.

. Save the layer as ‘AX_line’ and export the data to save it in your server (see point 14.

procedure 1).

. Go to Geoprocessing>Buffer.

. Select the ‘AX_line’ and choose the width of the buffer. To represent the whole Nether-

lands a buffer of 200 is recommended. Otherwise, for the visualization of single roads,
the Buffer can vary from 15 to 20 m, depending on the width of the road.

You can now choose different buffer options.

Save the buffer as ‘AX_BufferY’ (with Y = the width of the buffer. It is useful to have it
written).

Press OK.

The road is now represented with its Buffer. If you want you can now save the layer on
your server by exporting the data (see point 14 in procedure 1).
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F.3. Procedure 3 - Extract potential and represent road output in
ArcMap

1. Pick up a road and run it in the MATLAB code IEModel.mat filling the following input:
(a) roadsname (it is the name of the road and needs to be written as a string, ex. ‘Al’);

(b) numtif (it is the number of TIFF images that contain the road. They are numbered
in each file of the road. Write here how many they are);

(c) M.tech (specify the PV technology if you want to run the DC yield output as well);

(d) climate (choose if the North or South coefficients need to be used. Write ‘South’ or
‘North’);
(e) Change the name of the road in roads_array (needs to be fixed to be automatic);

(f) Change the name of the road in cd (needs to be fixed to be automatic);
2. After you made all these changes you can RUN the code.
3. Move the generated excel file into the right folder. It will be named in the following way:

* Irradiation excel file: ex. ‘A16’

* Poly c-Si DC yield file: ex. ‘A16_poly’

* Mono c-Si DC yield file: ex. ‘A16_mono’
* CIGS DC yield file: ex. ‘A16_CIGS’

4. Open the excel file and create a new first row above the data (ADD the row, don’t DELETE
the first row of data). Call the first column X, the second Y and the third

e Irr (if it is the irradiation file)
e DC (if it is the DC yield file)

It is very important that you name the columns, otherwise ArcMap will not recognize
them.

Save the excel file.
Open ArcMap.
Select Add Data.

® N o u

Find the excel file, click on it, click on ‘Sheetl$’ and press Add. Now the excel file is
loaded on ArcMap.

9. To give this file a spatial reference, ArcMap needs to recognize the coordinates and the
Z values to represent. Click on File > Add Data > Add XY Data. Choose the ‘Sheet1$’
and combine the X Field with the column X, the Y Field with the column Y and the Z
field with

¢ the column Irr if it is an irradiation file
* the column DC if it is a DC yield file

10. Press OK. ArcMap will then probably tell you that the table does not have object ID-
Field. It means that the file is just represented in the ArcMap file but is not an object
yet. Press OK.

11. Now your layer is represented in the Table Of Contents and also in the map. To make
your layer an object that you can modify and save, right-click on the layer and choose
Data > Export Data. Choose the folder where you want to save the shapefiles of the
results and name it as in point 2.

12. Answer YES when ArcMap asks you if you want to display the saved layer.
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13.

14.

15.

16.

17.

18.
19.

20.

21.
22.

23.

24.
25.

The new layer is now represented and is a full spatial object in ArcMap. Right-click on
the old layer and remove it.

Right-click on the new layer and choose Properties > Symbology > Quantities > Gradu-
ated colours.

In the box Value choose

e Irr (if it is the irradiation file)

* DC (if it is the DC yield file)
Automatically the classification of the data will be displayed. You can change it in
Classify > Method. It is important to you define the same classification for all the roads

that you are going to represent. Click on Classify and choose the number of classes,
colour and values for your classification.

Write down the statistics of the road in an excel file (you find them in the upper-right
part of the Classification window). These data describe the statistics of the results for
the single roads and can be very useful for the analysis.

Press OK and again OK. Now the road is displayed with the classification of the outputs.

To represent the interpolated values, go to the ArcToolbox > 3D Analyst Tools > Raster
Interpolation > Natural Neighbor (or another method of your choice).

Give the following input:

* Input point: layer of the road points.
e Z value: Irr (if it is the irradiation file), DC (if it is the DC yield file).
* Give a name to the output raster.

* Output cell size (suggested is 30)
Press OK and wait. It can take some time.

The interpolation is now displayed on the map. To cut only the road go again to ArcTool-
box > Data Management Tools > Raster > Raster Processing > Clip. Another method is
to use ‘Extract by Mask’ but I suggest to use Clip because it is faster and also represent
the roads better once you zoom out to see the whole map.

Give the following input:

* Input raster: interpolation raster layer of the road.
* Output extent: the buffer of the road (see procedure 2 to know how to create it).
* Tick on ‘Use Output Input Features for Clipping Geometry’.

* Give a name to your output raster.
Press OK and wait. It can take some time.

The clipped road is now displayed. If you want to change colour or classification, follow
step 13. For interpolated values, you should choose Stretched and then define the Type.
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